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1．はじめに 

アジレント・テクノロジーでは、マイクロアレイ実験をされる実務者の方を対象に DNA マイクロアレイ カ

ストマニュースを配信しています。実験プロトコルのアップデート・新製品のご案内・実験に関するトラブ

ルシュート・試薬や消耗品の保存など、実験を成功させるためのテクニカルサポートに内容を限定して、

E-mail でお送りしています。受信をご希望の方は「DNA マイクロアレイ カストマニュース配信希望」と明

記して、お名前・ご所属・配信を希望する E-mail アドレスを下記宛先までお知らせください。 

 email_japan@agilent.com 

本操作テキストは、アジレント Exon マイクロアレイあるいは原核生物マイクロアレイを用いた 2 色法解析

における、推奨ラベル化、ハイブリダイゼーション、洗浄、スキャニングと数値化の手順を記載しています。

弊社の Low Input Quick Amp WT Labeling Kit, Two-color （製品番号 5190-2944）は、弊社のマイ

クロアレイにあわせて最適化されています。他プロトコルで調製したラベル化サンプルをハイブリダイゼ

ーションに用いた場合、問題の生じるケースがあります。その場合はサポートの対象外になりますことを

ご了解ください。 

2 色法 

 

 

 

 

 

2 サンプルを 1 アレイにハイブリダイズし、アレイ内のシグナル強度比を測定 

 

プロトコルは予告なく変更になることがあります。プロトコルを日本語化するにあたり、作業時間が発生

するため、日本語プロトコルは英語の最新バージョンに比べて、遅れが生じます。製品ご購入の際は、

必ず製品添付の英語版プロトコルの Version をお確かめの上、日本語版が古い場合は、最新の英語版

を参照ください。 

本プロトコルは Gene Expression 2 色法対応 Low Input Quick Amp Labeling Kit Protocol 

ver6.5 に基づいていますが、以下の点が異なります。 

⚫ Low Input Quick Amp Labeling Kit の代わりに新しい Primer を含んだ Low Input Quick Amp 

WT Labeling Kit を使用します。 

⚫ Exon マイクロアレイと原核生物マイクロアレイ、Whole Transcript labeling に対応しました。 

⚫ T7 promoter primer の代わりに WT Primer Mix を使用します。 

⚫ 必要 Total RNA 量は Low Input Quick Amp Labeling kit と異なります。 

⚫ 本プトロコルでは、cRNA の Cyanine-3 取込率推奨値は 15pmol/ug です。 

⚫ アジレントの Exon マイクロアレイは SurePring G3 フォーマットのみの製品なので、 

読み取りには高解像度仕様の C スキャナまたは SureScan が必要です。 

原核生物マイクロアレイは本プロトコルを用いて 8x15K フォーマットでのみ実験検証を行っております。

他フォーマットに関してはお問い合わせください。原核生物マイクロアレイの実験に関してはアプリケーシ

ョンノート(5991-0879EN)もご参照ください。 

 

mailto:email_japan@agilent.com
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Ver.1.0_JP での更新点 

⚫ 実験に使用する Agilent キット fragmentation buffer のチューブに含まれる内容量の記載を 

改訂しました。 

⚫ 必要なものリストを見やすくしました。 

⚫ ラベル化 cRNA の NanoDrop による評価の記述を簡便化しました。 

⚫ ハイブリエイドの使い方の絵を一部修正しました。 

⚫ オーブンの写真を型番 G2545A のものに変更しました。 

⚫ Appendix：FE 用 Protocol のダウンロードサイトページのリンクを修正し、「現在」の日付を 

2017 年 4 月に変更しました。 

⚫ デザインファイルのダウンロード方法のリンクや情報を修正し、「現在」の日付を 

2017 年 4 月に変更しました。 
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2．使用するキットの確認 

Low Input Quick Amp WT Labeling Kit, two-color 48 反応分 

（製品番号 5190-2944） 

（※本キットは WT Primer Mix、Cyanine 3-CTP および Cyanine 5-CTP を含みます） 

＜内訳＞ 

⚫ WT Primer Mix 

⚫ Cyanine 3-CTP および Cyanine 5-CTP （24 反応分チューブ×各 1 本） 

⚫ Low Input Quick Amp Labeling Kit 単品 x2 （製品番号 5190-2308、24 反応分 

この製品番号の商品は WT Primer Mix, Cyanine 色素が含まれません。） 

Component  Volume 

T7 Promoter Primer(本プロトコルでは使用しません) 24 µL  

5xFirst Strand Buffer 100 µL 

0.1M DTT 70 µL 

10mM dNTP Mix 20 µL 

AffinityScript RNase Block Mix 36 µL  

5x Transcription Buffer 160 µL 

NTP mix 35 µL 

T7 RNA polymerase Blend 10 µL 

Nuclease Free Water 250 µL 

※本キットは-20℃で保存してください。 

※Cy3-CTPおよびCy5-CTPは、開封前は-20℃、融解後は4℃で保存してください。 

※WT Primer Mixのみ、Cyanine色素のみの販売はしておりません。 

※本キットでは25ng~100ngのtotal RNAから、ラベル化反応をスタートすることができます。 

ただし、マイクロアレイのフォーマットにより推奨量が異なりますのでご注意ください(後述)。 

※WT Primer Mixは梱包時にラベル化キットのボックスに含ま 

れておりません。WT Primer Mixのみが入った袋が一緒に 

届くので、見落とさないようにご注意ください。 

※遺伝子発現アレイ用ラベル化キットLow Input Quick  

Amp Labeling KitにはWT Primer Mixが含まれません。 

Exonマイクロアレイあるいは原核生物マイクロアレイの実験には必ずLow Input Quick Amp 

WT Labeling Kitをご使用ください。Cyanine色素なしのラベル化キットをお求めの場合、以下の

製品をご購入下さい。 

Low Input Quick Amp WT Labeling Kit,  (No dye) 24反応分 （製品番号 5190-2942） 

（※本キットは、WT Primer Mixを含みますが色素を含みません） 

アジレント RNA Spike-In キット（2 カラー用） （製品番号 5188-5279） 

⚫ Spike A Mix (10uL) 

⚫ Spike B Mix (10uL) 

⚫ Dilution buffer(1.2mL) ※全ての試薬は-80℃で保存してください。 
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アジレント Gene Expression Hybridization Kit （製品番号 5188-5242） 

Component 

25x Fragmentation Buffer  (400-500 uL) 

2x GE Hybridization Buffer HI-RPM (1.25mL x 2 本) 

10 x Blocking Agent (凍結乾燥) 

※本キットは開封するまでは室温で保存してください。 

※10x Blocking Agent を調製した後は、この試薬のみ-20℃で保存してください。 

※本キットの使用可能アレイ数は下記のようになります。 

1x1M 10 アレイ 

2x400K 20 アレイ 

4x180K 5 アレイ 

8x60K, 8x15K 100 アレイ 

※ 下記 2 つの試薬は個別に購入可能です。Gene Expression Hybridization Kit に含まれる試薬の 

10 倍量となります。 

2 x Hi-RPM Hybridization Buffer (5190-0403) 

10 x Blocking Agent (5188-5281) 

 

アジレント Gene Expression Wash 

Gene Expression 洗浄バッファ 1 4L  （5188-5325） 

Gene Expression 洗浄バッファ 2 4L  （5188-5326） 

アジレント Gene Expression Wash Pack (5188-5327) 

Gene Expression 洗浄バッファ 1（5188-5325）が 2 個、Gene Expression 洗浄バッファ 2

（5188-5326）が 1 個および TritonX-102(1.35mL のチューブ 6 本)のセットです。 

アジレント Stabilization and Drying Solution  -  500 mL （製品番号 5185-5979） 

※オゾンフリーブースがない場合にご使用ください。 

 

必要なソフトウェア 

アレイ 

フォーマット 

スキャナ スキャンコントロール 

ソフト 

Feature 

Extraction 

GeneSpring  

GX 

8x60K, 4x180K, 

2x400K, 1x1M 

高解像度仕様の 

C スキャナまたは

SureScan 

v8.4.1 以降 

（SureScan は v9.1） 

v10.7 以降 11.5 以降 

8x15K B スキャナ、 

C スキャナまたは

SureScan 

V7.0.1 以降 

（SureScan は v9.1） 

V9.5 以降  
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アジレント マイクロアレイ 

 

 

1x1M フォーマットは、１枚のスライドグラスに１枚のアレイが載

っています。 

 

 

 

1x1M フォーマット  

                 

2x400K フォーマットは、1 枚のスライドグラスに 2 枚のアレイが

載っています。 

 

 

 

2x400K フォーマット 

 

4x180K フォーマットは、1枚のスライドグラスに4枚のアレイが

載っています。 

 

 

 

4x180K フォーマット 

 

8x60K フォーマットおよび 8x15K フォーマットは、1 枚のスライ

ドグラスに 8 枚のアレイが載っています。 

  

 

 

8x60K フォーマット 8x15K フォーマット 

 

 

※ アレイは室温で保存して下さい。フォイル開封後は暗所・室温で、真空デシケータ中か、窒素パージ

した箱の中で保管して下さい。開封後は、マイクロアレイスライドを外気にさらさないで下さい。 

105 K105 K400 K 400 K 

44K44K44K44K180K 180K 180K 180K 

60K 

60K 

60K 

60K 

60K 

60K 

60K 

60K 

244 K 1M 

15K 15K 15K

15K 15K 15K15K

15K
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3．実験に必要な消耗品など 

アジレント Exon アレイ実験に必要な消耗品および器具のリスト（実験プロトコル Exon v1.0 対応） 

(2014 年 11 月作成） 

対応マイクロアレイフォーマット：1x1M, 2x400K, 4x180K, 8x60K  

※ 指定：必ず指定されたものをご使用ください。指定品以外を使用された場合は保証の対象外になります。 

※ 推奨：安定した結果を得るために推奨品の使用をお奨めします。 

推奨品以外の製品を使用された場合、アプリケーションサポートの対象外になります。 

※ 相当：備考欄に記載された条件を満たすものなら、他製品をご使用されてもかまいません。 

■消耗品（青文字は Agilent 製品です） 問い合わせ先：アジレント・テクノロジー株式会社 (電話 0120-477-111) 
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4．実験に必要な機器・器具 

 

【マイクロアレイの保管について】 

■ 開封前のマイクロアレイは、室温で保存をして下さい。マイクロアレイのフォイルの袋開封後は、マイ

クロアレイのスライドは室温の暗所で、真空デシケータか窒素パージしたボックスで保管をしてくださ

い。開封後は高湿・温度変化・外気との接触を極力避けて下さい。 

【試薬・消耗品の保管について】 

■ Cyanine 3-CTP は、使用するまで-20℃以下での保存を推奨しています。一旦融解して使用を開始

した後は、凍結融解の繰り返しを避けるために、開封後は 4℃、遮光状態で保管してください。 

【試薬・消耗品の保証期間について】 

■ アジレントマイクロアレイおよびその他のアジレント製品の保証期間は、箱やチューブの入った小袋

あるいはボトルに記載の Expiration date(Exp. date)までです。保証期間を過ぎた製品については

欠品等があった場合も交換ができない場合がありますので、製品が納品されたらすぐに内容物を確

認して下さい。 

■ 保証期間を過ぎると性能の保証ができないため、保証期間内に使用するように計画して下さい。 
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5．実験を始める前に 

 

⚫ 実験室内では必ず白衣、手袋、必要に応じてマスク、眼鏡をご着用ください。 

⚫ スライドグラスの縁は鋭利です。手袋をはめ、十分注意して取り扱ってください。 

⚫ 本実験では、毒性のある試薬を使用します。弊社でも留意しておりますが、操作時の安全には、

各自で十分ご注意いただきますよう、お願い申し上げます。 

⚫ 毒性のある溶液に触れたチップやチューブの廃棄場所は、弊社担当者にご確認ください。 

⚫ Cyanine 3-CTP と Cyanine 5-CTP は発癌性物質を含んでいます。吸引、誤飲、皮膚への直接

の接触は避けてください。 

⚫ RNase のコンタミネーションを防ぐために、実験中はパウダーフリーの手袋を着用し、ヌクレアー

ゼフリーの溶液およびピペットチップを使用してください。 

⚫ Cyanine 3-CTP と Cyanine 5-CTP は光で分解します。出来る限り光にあたらないように注意し

て使用してください。保管時，反応時は必ず遮光してください。 

⚫ 本キット中のハイブリダイゼーションバッファには塩化リチウム(LiCl)が含まれています。 

塩化リチウム(LiCl)には中枢神経系への毒性があります。 

催奇性があり、乳児に悪影響を与える可能性があります。 

不妊を誘発する可能性があります。 

吸入、皮膚接触、誤飲により、害を引き起こします。必ず適切な白衣、手袋、マスク、防護めがね

等を着用してください。 

⚫ ハイブリダイゼーションバッファにはラウリル硫酸リチウム(LLS)が含まれています。 

ラウリル硫酸リチウム(LLS)は毒性があり、目、気管器系、皮膚に炎症を起こす可能性があります。

必ず適切な白衣、手袋、マスク、防護めがね等を着用してください。 

⚫ ハイブリダイゼーションバッファには Triton が含まれています。誤飲により害を引き起こします。ま

た、目に入った場合深刻なダメージを与えます。 

⚫ Agilent Stabilization and Drying Solution (cat. No. 5185-5979)は、毒性、引火性があります。

必ず、適切なヒュームフード（ドラフト）内で使用して下さい。また、有機溶媒を含んでいますので、

HPLC 廃液およびフェノール廃液と同様な廃棄処理を行ってください。 

⚫ アセトニトリルは引火性と揮発性があります。吸引、皮膚接触、誤飲により肝臓、腎臓、循環器、

中枢神経系害を引き起こします。 

⚫ 実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お問い合

わせ頂く際はこれらの情報を添えて、お問い合わせ下さい。 
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6．プロトコルの全体図 

 

 

 

 

     

RNAtotal RNA 
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実験のタイムテーブル 

 

Step Temperature  Time 

cDNA合成 155 min 

プライマーとテンプレートの熱変性 65ºC 10 min 

急冷 氷上 5 min 

二本鎖cDNA合成 40ºC 120 min 

逆転写酵素の失活 70ºC 15 min 

急冷 氷上  5 min 

cRNA合成 120 min 

cRNA合成 40ºC 120 min 

cRNA精製 30 min 

cRNA精製 RT  30 min 
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7．実験の操作手順 

 

１日目：実験の前準備 

 

⚫ 実験を始める前に、以下のものを準備してください。 

➢ マイクロピペッター（RNA 用） 1-10 uL,10-100 uL,100-1000 uL の３本 

➢ ピペットチップ（RNA 用） 上記各サイズ対応 

➢ チューブ立て 

➢ 1.5 mL チューブ（RNaseFree） 

➢ アイスボックス  

➢ Nuclease-free water 

➢ 96-100％ エタノール 

➢ タイマー 

➢ ボルテックスミキサー 

➢ パーソナル遠心機(スピンダウン用) 

➢ 油性ペン 

 

⚫ あらかじめ使用する機器の温度設定をしておきます。 

➢ ウォーターバスを 37℃、40℃に設定。cRNA 増幅＆ラベル化反応後 60℃に設定 

➢ ヒートブロックを 65℃、80℃に設定。cDNA 合成後 70℃に設定 

 

⚫ 使用する試薬を解凍しておきます。 

➢ 酵素以外の試薬は、指定がない限り室温より高い熱をかけずにできるだけ早く溶かします。

ボルテックスミキサーで撹拌し、5~10 秒スピンダウンして液を底に集めます。 

➢ 酵素は軽くスピンダウンします。 

➢ 全ての試薬は使用直前まで氷上においておきます。 

※ 反応には、Cyanine 3-CTP (10mM) および Cyanine 5-CTP (10mM) を各 0.24 uL ずつ

使用します。事前に反応数を確認し、十分な Cyanine Dye が手元にあるようにします。 
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8．実験：１日目 

（必ずプロトコルを参照ください。） 

 

8-1. RNA Spike A および B Mix の調製（オプション） 

Spike-In kit に含まれる Spike-Mix を Dilution Buffer で希釈し、希釈物をスタート RNA に添加します。

ラベル化に用いるスタート RNA 量によって、Spike-Mix の希釈率が変わります。 

実験に使用する total RNA は、    ng です。下記の表を参照すると、今回の希釈手順は、それぞれ、

以下の通りになります。 

 

※ 37℃、5 分間の加温を行ない、Spike A および Spike B Mix （原液）を溶かします。ボルテックスで

混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。以下の手順に従い、Spike A

および Spike B をそれぞれ希釈します。 

 

1st : 2uL の Spike A あるいは Spike B Mix に 38uL の Dilution Buffer を加えます（1:20） 

・ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。  

2nd : 2uL の 1st 希釈液（Spike A あるいは Spike B）に 78uL の Dilution Buffer を加えます（1:40） 

・ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

3rd : 2uL の 2nd 希釈液（Spike A あるいは Spike B）に 30uL の Dilution Buffer を加えます（1:16） 

・ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

4th :    uL の 3rd 希釈液（Spike A あるいは Spike B）に    uL の Dilution Buffer を加えます（1:    ） 

・ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

重要 Spike A は Cy3 でラベル化するサンプルに、Spike B は Cy5 でラベル化するサンプルに加えま

す。絶対に間違いの無いようにして下さい。 

 

注意 Spike-in 量の精度を確保するため、Spike-Mix を調製する場合は、2 uL 以上の量を扱うように

してください。 

 

※ 調製した 1st 希釈液は、‐70 ～ ‐80℃で約 2 ヶ月まで保存できます。さらに 8 回までの凍結融解

を繰り返すことが可能です。2nd、3rd および 4th 希釈液は保存、再利用できないので実験の都度調

製します。 

スタート RNA 量 希釈手順 4th Spike- Mix の 

必要量(uL)/反応 

total RNA (ng) 1st  2nd 3rd 4th 

25 1:20 1:40 1:16 1:8 2 

50 1:20 1:40 1:16 1:4 2 

100 1:20 1:40 1:16 1:2 2 
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8-2. total RNA からのラベル化 cRNA の合成 

Low Input QuickAmp WT Labeling Kit は、25 ng から 100ng の範囲の total RNA からラベル化 cRNA

を合成することができます。 

ただし 

⚫ 十分量のラベル化 cRNA を得るためには、マイクロアレイフォーマットに関わらず 50ng 以上の total 

RNA を用いることをお勧めします。 

⚫ RNA 量は一連の実験系では揃えることをお勧めします 

 

⚫ 反応チューブにサンプル名を書いてください。 

⚫ 1 反応あたりに使用する試薬量は 1uL 以下になるので、必ずマスターミックスを調製後、各チュー

ブに分注してください。 

各マスターミックスは、4 反応の場合は 5 反応分、8 反応の場合は 10 反応分を調製してください。 

 

1. 1.5mL のチューブに、25ng から 100ng の totalRNA を最終量が 2.3uL になるよう加えます。 

濃度が濃い場合は希釈してください。2.3uL を超えないようにしてください。 

 

注意 チューブへの吸着を防ぐために、totalRNA は 100ng/uL 以上で保存してください。 

100ng/uL 以下にする場合は、使用直前に調製しすぐ使用してください。 

 

2. 下記表に従い Spike MixA あるいは Spike MixB を使用した 2 種の WT Primer Master Mix を調製し

ます。WT Primer Mix はを調製します。例えば Cy3 あるいは Cy5 でラベル化するサンプルが各 4 チ

ューブずつある場合、それぞれのマスターミックスを 5 反応分ずつ調製してください。 

1反応分の必要量(uL) 5反応分(uL) 10反応分(uL)
WT Primer Mix 1 5 10
希釈したSpike Mix A あるいはSpike
Mix B

2 10 20

 トータル量 3 15 30  

注意 Low Input QuickAmp WT Labeling Kit には、WT Primer Mix と T7 Promoter Primer が含まれ

ています。ここでは必ず WT Primer Mix をご使用ください(本プロトコルでは T7 Promoter  

Primer は使用しません)。 

 

3. Spike MixA を含む T7 Promoter Primer Mix を Cy3-CTP でラベル化する total RNA に 3uL ずつ加

え、Spike MixB を含む T7 Promoter Primer Mix を Cy5-CTP でラベル化する total RNA に 3uL ず

つ加えます。ピペッティングあるいはタッピングで良く混合後、スピンダウンします。合計 5.3uL になり

ます。Spike Mix と蛍光色素の組み合わせを間違えないようにしてください。 

 

4. 65℃で 10 分インキュベーションします（熱変性）。 

 

5. 氷で急冷、そのまま 5 分間冷却します。 

  



 
Low Input Quick Amp WT Labeling Kit 2 色法実験プロトコル 17 

6. 5x First Strand Buffer は事前に 80℃のウォーターバスで 3－4 分間温めます。ボルテックスでよく

混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。使用するまで室温で置いておき

ます（氷上に置くと、析出する場合があります）。使用直前に再度析出物がないか確認してください。

ロットによって析出し易い場合があります。室温にもどすとすぐ析出する場合は、以下の手順で溶解

してください。 

a. 5xFirst Strand Buffer を 80℃のウォータバスで 5 分間加熱し、10 秒以上ボルテックスにかけ 

スピンダウンします。5 分間室温におきます。 

b. 5 分後、析出物が確認されない場合は、速やかにマスターミックスを調製します。 

c. 5 分以内に析出物が確認された場合は再び 80℃のウォータバスで 4 分ほど加熱し、10 秒間

ボルテックスしてスピンダウンします。 

d. 室温におき、5 分以内にマスターミックスを調製します。 

 

 

7. 下記表に従い cDNA マスターミックスを調製します。ピペッティングで混合し、スピンダウンします。使

用するまで室温に置いておきます。 

AffynityScript RNase Block mix は酵素の混合物です。使用直前まで氷上に置いておきます。 

AffynityScript RNase Block mix を添加後もマスターミックスは氷上ではなく室温に置き、添加後すぐ

に使用してください。 

1反応分の必要量(uL) 5反応分(uL) 10反応分(uL)  
  5xFirst Strand Buffer(緑キャップ) 2 10 20
　0.1M DTT(緑キャップ) 1 5 10
　10mM dNTP mix(緑キャップ) 0.5 2.5 5
　AffinityScript RNase Block Mix
(紫キャップ)

1.2 6 12

　トータル量 4.7 23.5 47

 

8. 氷上で冷やしていた各チューブをスピンダウンし、チューブ蓋などについた水滴を落とします。 

 

9. cDNA マスターミックス 4.7uL を各チューブに加え、ピペッティングで良く混合し、スピンダウンしま

す。総量は 10uL になります。 

              

10. 40℃のウォーターバスで 2 時間インキュベーションします。 

 

11. 70℃で 15 分間インキュベーションし、酵素を失活させます。 

4.7uL

cDNA合成反応
マスターミックス
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12. サンプルチューブを氷上に移し、5 分間冷却します。 

13. 各チューブをスピンダウンし、チューブ蓋などについた水滴を落とします。 

※ ただちに実験を進めない場合、サンプルを-80℃で保存することができます。 

14. 下記表の試薬を上から順に加え、Transcription Master Mix を室温で調製します。 

T7 RNA Polymerase Blend は酵素の混合物です。使用直前まで氷上に置きおきます。T7 RNA 

Polymerase Blend を添加後もマスターミックスは氷上ではなく室温に置き、添加後すぐに使用して

ください。 

注意 Cy3-CTP 用および Cy5-CTP 用のマスターミックスをそれぞれ調製します。 

 

各 Transcription Master Mix に Cy3-CTP または Cy5-CTP のどちらか一方を加えます。例えば Cy3 あ

るいは Cy5 でラベル化するサンプルが各 4 チューブずつある場合、それぞれのマスターミックスを 5 反

応分ずつ調製してください。 

1反応分の必要量(uL) 5反応分(uL) 10反応分(uL)  
 Nuclease-free water(白キャップ) 0.75 3.75 7.5
5xTranscription Buffer(青キャップ) 3.2 16 32
0.1M DTT(緑キャップ) 0.6 3 6
NTP mix(青キャップ) 1 5 10
T7 RNA Polymerase Blend (赤キャップ) 0.21 1.05 2.1
Cyanine3-CTPまたは
Cyanine5-CTP

0.24 1.2 2.4

　トータル量 6 30 60  

スキャン後の蛍光の色と、色素自体の色が異なりますので、十分に注意してください。 

色素が光にさらされる時間を極力短くしてください。 

 

15. 各チューブにそれぞれの Transcription Master Mix を 6uL 加え、ピペッティングで穏やかに混ぜた

後、スピンダウンします。ラベル化するサンプルと色素の組み合わせを間違えないようにしてくださ

い。総量は 16uL になります。 

 

16. 40℃で 2 時間インキュベーションします。 

ウォーターバスあるいはヒートブロックにアルミをかぶせ、遮光してください。 

 

※ ただちに実験を進めない場合、インキュベーション終了後サンプルを－80℃で保存することができ

ます。 

  

6.0uL

Cy3-Transcription
Master Mix

6.0uL

Cy5-Transcription
Master Mix
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ハイブリダイゼーションを引き続き当日中に行う場合には、インキュベーション終了後、以下の設定をし

ておきます。 

⚫ ウォーターバスまたはヒートブロックを60℃に設定 

⚫ ハイブリダイゼーションオーブンを65℃に設定(ローターを取り付けておきます)。 

オーブン庫内が表示温度で安定するまでに 1 時間~1 時間半かかります。 

 

 

8‐3．Cyanine3-あるいは Cyanine5-ラベル化 cRNA の精製 

StratageneのAbsolutely RNA Nanoprep KitあるいはQiagenのRNeasy Mini Kitを使ってラベル化

cRNAを精製します。この精製ステップにより、ラベル化の際に取り込まれなかったラベル化ヌクレオチド

（モノマー）を除去することができます。モノマーが、ハイブリダイゼーション液中に存在すると、マイクロア

レイのバックグランドの蛍光が著しく高くなります。 

 

⚫ ラベル化cRNAの精製には、Qiagen RNeasy Mini Kitの使用を推奨します。 

⚫ Stratagene Absolutely RNA Nanoprep KitはQiagen RNeasy Mini Kitに比べて溶出量が少ない

ので、ラベル化cRNAをより高濃度で精製することができます。少量サンプルからラベル化をスター

トした場合は、Stratagene Absolutely RNA Nanoprep Kitをお勧めします。 

⚫ データの相互比較が必要なプロジェクト内では、精製キットはどちらかに統一することをお勧めしま

す。 

 

【Qiagen RNeasy Mini Kitを用いて精製する場合】 

以下に記載してある手順に従って実験を進めてください(Qiagenのプロトコルを一部変更しています)。 

⚫ 使用前に、RPEバッファにエタノール(96-100%)を必要量加えてください。RPEバッファは次のペー

ジの洗浄ステップで使用します。調製が終わりましたら、フタのラベルのethanolの項目にチェックマ

ークを付けてください。 

⚫ 全ての遠心のステップは、13,000rpm(10,000g)以上の回転数で行ってください。 

⚫ 遠心を4℃で行うことにより、cRNAの収率があがることが確認されております。以下の遠心ステップ

を4℃で行うことを強くお奨めします。 

⚫ RLTバッファにβ-メルカプトエタノール(β-ME)を加える必要はありません（β-MEが入っていても問

題ありません）。 

 

1. 84 uLのNuclease-free waterをcRNAに加え、液量を100 µLにします。 
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2. 350 uLのRLTバッファを加え、混合します。 

 

3. 250 uLのエタノール（96-100%）を加え、ピペッティングで静かに混合します。 

スピンダウンを含め遠心はしないで下さい。 

 

 

4. 700 uLのcRNAサンプルを2 mLのコレクションチューブをつけたRNeasy miniカラムに移します。 

カラムチューブを13,000 rpmで30秒間遠心します。カラムを素通りした液は捨てます。 

 

 

 

 

 

 

 

 

5. RNeasyカラムを新しいコレクションチューブに移し、500 uLの調製済みのRPEバッファ（エタノール

が加えられたもの）をカラムに加えます。カラムチューブを13,000 rpmで30秒間遠心します。カラム

を素通りした液は捨てます。 

 

 

 

 

 

 

 

6. コレクションチューブはそのまま使用し、再度500 uLのRPEバッファをカラムに加えます。カラムチュ 

ーブを13,000 rpmで1分間遠心します。カラムを素通りした液は捨てます。 

もしカラムのフリットにRPEバッファが残っていれば、カラムを新しい1.5mLチューブに移し、

13,000 rpmで1分間遠心し、残っているRPEバッファを完全に取り除きます。 

 

7. RNeasyカラムを新しい1.5 mLのコレクションチューブに移します。 
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8. 30 uL のNuclease-free waterをカラムのフィルター中央に加え、1分間おきます。カラムチューブを

13,000 rpmで30秒間遠心します。カラムを通った液はそのまま残します（液を捨てないように注意し

てください）。 

 

9. チューブは氷上においておきます。使用済みのカラムは捨てます。回収したcRNAの濃度、収量およ

び品質をUV測定とバイオアナライザを用いて確認します。 

 

 

【Stratagene Absolutely RNA Nanoprep Kitを用いて精製する場合】 

事前準備 

1．80%スルフォランの調製 

 a.100%スルフォランを溶けるまで37℃で温めます。100%スルフォランは室温で固体ですが、

80%スルフォランは室温で液体のまま、最低1ヶ月は保存できます。 

 b.1mLのRNase-free水を4mLの100%スルフォランに添加し、5mLの80%スルフォランを調製しま

す。5mLの80%スルフォランで50回精製できます。 

2．1 x High-Salt Wash Bufferの調製 

 a.16mLの100%エタノールを1.67 x High-Salt Wash Bufferに添加します。 

 b.ふたを閉め、よく振って混合します。ふたの1x(Ethanol Added)にチェックを入れます。室温で保

存します。 

3．1 x Low-Salt Wash Bufferの調製 

 a.68mLの100%エタノールを5 x Low-Salt Wash Bufferに添加します。 

 b.ふたを閉め、よく振って混合します。ふたの1x(Ethanol Added)にチェックを入れます。室温で保

存します。 

 

精製操作 

遠心は4℃で行ってください。 

1. 100uLのLysis BufferをcRNAサンプルに加え、116uLにします。ピペッティングでよく混合し、スピン

ダウンします。 

2. 等量（116uL）の80%スルフォランを加え、cRNAサンプルと混ざるまでボルテックスで混合し、スピン

ダウンします。 

3. RNA-binding nano-spin cupを2mLのコレクションチューブに入れます。 

4. 80%スルフォランとcRNAサンプルの混合物をRNA-binding nano-spin cupに全量移し、

RNA-binding nano-spin cupにキット付属のキャップをはめます。 

5. 12,000g以上で、60秒遠心します。 

6. 遠心後、溶液がRNA-binding nano-spin cupに残っている場合は、素通りした液を捨て再度遠心して

ください。溶液が残っていない場合は、カラムを素通りした液は捨て、RNA-binding nano-spin cupを

コレクションチューブに戻します。 
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7. 300uLのHigh-Salt Wash BufferをRNA-binding nano-spin cupに加え、キャップをはめ、12,000g

以上で60秒遠心します。 

8. 遠心後、溶液がRNA-binding nano-spin cupに残っている場合は、素通りした液を捨て再度遠心し

てください。溶液が残っていない場合は、カラムを素通りした液は捨て、RNA-binding nano-spin 

cupをコレクションチューブに戻します。 

9. 300uLのLow-Salt Wash BufferをRNA-binding nano-spin cupに加え、キャップをはめ、12,000g

以上で60秒遠心します. 

10. ステップ8およびステップ9をもう一度繰り返します。 

11. 遠心後、溶液がRNA-binding nano-spin cupに残っている場合は、素通りした液を捨て再度遠心し

てください。溶液が残っていない場合は、カラムを素通りした液は捨て、RNA-binding nano-spin 

cupをコレクションチューブに戻します。 

12. 300uLのLow-Salt Wash BufferをRNA-binding nano-spin cupに加え、キャップをはめ、12,000g

以上で3分遠心します。 

13. RNA-binding nano-spin cupを新しい2mLのコレクションチューブに移します。 

14. 20uLのElution BufferをRNA-binding nano-spin cupに加えます。キャップをはめ、室温で2分間静

置します。60℃に温めたElution Bufferを用いると収量が上がります。 

15. 12,000g以上で5分遠心します。 

16. 収量を上げたい場合、ステップ14およびステップ15を繰り返します。ただし、ハイブリダイズに必要

な濃度を下回る可能性があります。 

17. 溶出された液をふた付きのチューブに移します。チューブは氷上におき、回収したcRNAの濃度、収

量及び品質をUV測定とバイオアナライザを用いて確認します。 
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8-4. ラベル化 cRNA の分析 

【NanoDropによる評価】 

通常500 ngのトータルRNAからスタートした場合、2.0 – 4.0 ugのcRNAを合成できますが、トータルRNA

の純度や質(分解度)によっても異なります。合成したcRNA量は、通常のキュベットを使った分光光度

計で測定するには少なすぎる場合がほとんどです。濃度決定に使用するRNA量を最小限に抑えるた

めに、本プロトコルではNanoDrop分光光度計を推奨しています。 

⚫ NanoDropのソフトウェアを起動し、”Microarray Measurement”のタブを選択します。 

Sample Type は RNA-40 と選択します。 

⚫ 1 uLのヌクレアーゼフリー水で、NanoDropでブランクを設定します。 

⚫ 1 uLの増幅 (ラベル化) cRNAを測定し、A260とA550とA650を記録します。 

 

(1) NanoDrop 計測結果より、cRNA濃度 （ng/uL）を記録します。 

RNA濃度が自動算出されない分光光度計をご使用の場合、A260の値から以下の式で算出して下さい。 

cRNA conc. (ng/uL) * = A260 x 40 ug/mL x dilution factor** 

*光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

**希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

(2) (1)のcRNA濃度（ng/uL）に溶出量（ 使用した精製キットにより30 ul あるいは20 ul ） 

を乗じ、以下の式でcRNA収量を算出します。 

cRNA yield(ug) = cRNA conc(ng/uL) × 30(uL) / 1000  

 

(3) NanoDrop 計測結果より、CyDyeの濃度 (pmol/ul)を記録します。 

色素濃度が自動算出されない分光光度計をご使用の場合、A550 (Cy3)、A650(Cy5)の値から以下の式で算出し

て下さい。 

Cy3-CTP conc (pmol/ul) * = A550 x 1000 ÷ 150 mM-1cm-1 x dilution factor** 

Cy5-CTP conc (pmol/ul) * = A650 x 1000 ÷ 250 mM-1cm-1 x dilution factor** 

*光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

**希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

(4) 以下の式で、CyDyeの濃度と取込率を算出します。 

 

Cy3-CTP incorporation (ng/uL) = Cy3-CTP conc.(pmol/uL) ×1000 

cRNA conc. (ng/uL) 

 

Cy5-CTP incorporation (ng/uL) = Cy5-CTP conc.(pmol/uL) ×1000 

cRNA conc. (ng/uL) 
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cRNAの収量およびCy3-CTPあるいはCy5-CTPの取り込み率が下記基準を満たしているか確認します。

基準を満たさない場合には、再度cRNAの調製をされる事をお勧めいたします。ただしスタートtotal RNA

量によっては十分量得られない場合があります。 

また測定した濃度から、マイクロアレイへのハイブリダイゼーションに必要な cRNA 量を計算します。 

アレイフォーマットによって必要量が異なるのでご注意ください。 

マイクロアレイフォーマット 収量（ug) 
Cy3-CTP あるいは Cy5-CTP 

取り込み率 (pmol/ug) 

1x1M 2.5 15 

2x400K 1.875 15 

4x180K 1.65 15 

8x60K、8x15K 0.825 15 

 

【バイオアナライザによる評価】 

⚫ 1.5mLチューブに1.5uLのラベル化cRNAを分注します。熱変性（70℃2分）を行い、氷上に置きます。  

1uLをバイオアナライザの測定に用います。 

⚫ バイオアナライザでラベル化 cRNA を泳動する際は、mRNA assay を選択します。 

バイオアナライザの分析例 

 

ラベル化サンプルのシグナルの大部分が、200 から 2000 塩基長のサイズ範囲に位置しているかを確認

して下さい。これ以外の領域にピークの大部分がある場合、正確なデータが出ない可能性があります。 

バイオアナライザの検出チャネルは Cy5 も励起するため、Cy5 でラベル化したサンプルのデータは Cy3

に比べてピークが高くなる傾向があります。 

データ分析時に、ツールバーのアイコン をクリックすると、横軸の表示を秒あるいは nt に切り替

えられます。 

 

ラベル化 cRNA の保存 

cRNA を直ぐに使用しない場合には、少量に分注し、暗所-80℃で保存します。長期保存の場合は、チュ

ーブに分注して保存して下さい。 

サンプルの冷凍、解凍のサイクルを繰り返すと cRNA が分解しやすくなります。保管している cRNA   

の品質がわからない時は、バイオアナライザおよび UV 計で品質を再確認することをお勧めします。
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8-5．ハイブリダイゼーションの準備 

増幅反応を行っている間に、次のものを準備してください。 

マイクロアレイやガスケットスライド、試薬の Expire date を確認してください。古いものを使用するとノ

イズが上がる等トラブルが発生する可能性があります。 

➢ アジレント Exon マイクロアレイ  

➢ 遺伝子発現ハイブリダイゼーションキット 

➢ ハイブリダイゼーションチャンバ 

➢ ガスケットスライド 

➢ ピンセット（清潔なもの） 

➢ パウダーフリー手袋  

➢ マイクロピペッター（RNA 用） 1-10uL,10-100uL,100-1000uL およびピペットチップ（RNA 用）  

➢ 1.5 mL チューブ（RNase Free） 

➢ チューブ立て（RNA 用） 

➢ 高速遠心機 

➢ ボルテックスミキサー 

➢ アイスボックス 

➢ タイマー 

➢ ヒートブロック、またはウォーターバス（60℃） 

➢ ハイブリダイゼーションオーブン（65℃） 

使用する機器の温度設定を確認しておきます。 

➢ ウォーターバスまたはヒートブロックを 60℃に設定 （増幅反応終了後に変更します） 

➢ ハイブリダイゼーションオーブンを 65℃に設定（ローターを取り付けておきます） 

庫内が表示温度で安定するまでに1時間~1時間半かかります。早めに設定をしておいて下さい。 

≪ハイブリダイゼーションオーブン温度の校正法≫ 

ハイブリダイゼーションの温度はマイクロアレイのシグナル強度やノイズレベルに大きな影響を及ぼし

ます。表示温度と実測値が一致するか 3 ヶ月に 1 度は確認し、0.2 ℃以上異なる場合は下記手順で校

正してください。 

1. オーブンのローターと、使用するスライド数とバランスをあわせてチャンバをセットします。 

2. 温度を 65℃、回転数を 10 にセットし、温度が安定するまで 3 時間ほど待ちます。 

3. 校正済みの温度計をセットします。 温度センサー部位をとりつけます。この時センサー部位がオー

ブンの壁につかないように、空間の温度をはかるようにして下さい。 

4. 3 時間程度、温度計の温度が安定するまで待ちます。 

5. 実測温度と設定温度を比較し、0.2 ℃以上異なるようであれば、次の手順で合わせます。 

6. オーブンの ▲ ボタンと ▼ボタンを同時に押し、温度表示が点滅するまで待ちます。あるいは ▲ 

ボタンと ▼ボタンを同時に長押し、温度両側の「.」が点滅するまで待ちます。 

7. 点滅しているうちに、▲ボタンと▼ボタンで、表示温度を温度計が示す温度にあわせます。 

8. その後再度表示を 65℃にあわせ 3 時間ほど待ち、表示温度が実測値と合うか確認します。 

詳細は弊社サポートサイトの「Agilent G2545A ハイブリダイゼーションオーブン校正方法」をご覧く

ださい。 
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8-6．マイクロアレイの取り扱い上の注意 

 

◼ マイクロアレイはバーコードラベルに”Agilent”の文字が

入っている面に載っています。Agilent の文字が入ってい

る面が Active サイド、数字だけのバーコードラベルが付い

ている面は Inactive サイドです。 

◼ ハイブリダイゼーションを行う際は、アレイがプリントされて

いる Active サイドに、必ず溶液をアプライするように注意してください。 

◼ 各オリゴ DNA マイクロアレイのレイアウトやサイズなどの詳細な情報については、付録をご参照く

ださい。 

◼ スライドグラスを取り扱う際は手袋をはめ、スライドグラスの縁を注意深く持って取り扱って下さい。

スライド表面には両側とも決して触らないで下さい。 

◼ スライドグラスを取り扱う際は、必ずパウダーフリーの手袋を着用してください。 

◼ ハイブリダイゼーション、洗浄のステップでアレイを乾燥させないように注意して下さい。 

◼ ハイブリダイゼーションを行う前に、実験机を整理整頓して下さい。ハイブリダイゼーション器具の周

りはなるべく障害物がない状態を作ってから次ページ以降の操作を行って下さい。 

◼ ハイブリダイゼーションは水平な実験台で行って下さい。下記ハイブリエイドをお持ちの場合は、内

蔵の水準器で水平が確認できます。ハイブリダイゼーション作業を始める前に予めご確認ください。 

◼ 手でアレイスライドをガスケットスライドに乗せるのが難しい場合、オプションとして、ハイブリエイドを

用いてアレイスライドを乗せることが出来ます。 

 ※ハイブリエイドはハイブリダイゼーション作業を補助するオプションの器具です。 

 

8-7．ハイブリダイーゼーション溶液の調製 

8-7-1． 10x Blocking Agent の準備 

1. スピンダウンしてペレットをチューブの底に集めます。 

2. Nuclease-Free Water を 0.5ml, Blocking Agent に加えます。 

3. 穏やかにボルテックスをして溶解します。溶解しない場合は 37℃で 4, 5 分温めます。 

4. 5～10 秒スピンダウンし、チューブの蓋や壁についた液を集めます。 

5. 調製した 10x Blocking Agent は-20℃で 2 か月間保存できます。凍結融解が 5 回以内になるように  

分注して保存してください。融解後は上記ステップ３、４を行って下さい。  
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8-7-2. フラグメンテーション溶液の調製 

1．下表に従い、Cy3 ラベル化及び Cy5 ラベル化 cRNA、10x Blocking Agent、Nuclease-free water お

よび 25x Fragmentation Buffer を 1.5 mL チューブに加え、緩やかにボルテックスをしてサンプルを十

分に攪拌してください。複数のサンプルチューブがある場合は、全てのチューブにラベル化 cRNA、

10x Blocking Agent および Nuclease-free water を調製し、最後に Fragmentation Buffer を各チュ

ーブに添加してください。 

1 パックおよび 2 パック使用時に十分量の cRNA がない場合は、1.65ug まで下げることができます。

ただし比較したいサンプル同士は同じ量をハイブリダイズに用いてください。 

 

Fragmentation mix

アレイフォーマット 8pack 4x180K 2x400K 1x1M

Cy3-labeled cRNA 300ng 825ng 1.875ug 2.5ug
Cy5-labeled cRNA 300ng 825ng 1.875ug 2.5ug
10xBlocking Agent 5uL 11uL 25uL 50uL
Nuclase-free water 適量 適量 適量 適量
25xFragmentation 1uL 2.2uL 5uL 10uL
トータル量(マイクロアレイあたり) 25uL 55uL 125uL 250uL  

8pack：8x60K および 8x15K 

 

 

2. 60℃のウォーターバスで30分インキュベーションします。必ず遮光してください。 

断片化(インキュベーション)が30分を超えない事が重要です。 

3. 30分後、ただちにサンプルを氷水上に移し、1分間冷却します。その後速やかに、断片化をストップさ 

せるため、下表に従って2XGE Hybridization Buffer HI-RPMを加えます。 

 

  

Hybridization mix

アレイフォーマット 8pack 4x180K 2x400K 1x1M

Fragmentation溶液 25uL 55uL 125uL 250uL

2xGE Hybridization Buffer HI-RPM 25uL 55uL 125uL 250uL

トータル量(マイクロアレイあたり) 50uL 110uL 250uL 500uL
 

 

4．ピペットでゆっくりと液を混合させます。泡を立てないように十分に気をつけてください。泡が発生しま

すので、ボルテックスは使用しないようにしてください。 

5．高速遠心機でスピンダウンして(13,000 rpm、1分、室温)、蓋や壁についた液を底に集めます。 

6．サンプルを氷上に置き、直ちにハイブリダイゼーションに使用してください。保存はできません。  
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8-8．ハイブリダイーゼーションチャンバの組み立て 

ハイブリチャンバを組み立てるにあたり、以下のキットが必要になります。 

ハイブリダイゼーションチャンバ (G2534A) 

 

 

 

 

 

 

 

 

 

 

 

 

 

ガスケットスライド： 

1x1M 用 (G2534-60003), 2x400K 用 (G2534-60002), 4x180K 用(G2534-60011), 

8x60K および 8x15K 用(G2534-60014) 

 

 

 

 

 

 

 

 

 

 

■（オプション）ハイブリエイド 

 

 

 

 

 

 

 

  

チャンバ－ベ－ス

チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット

チャンバ－ベ－ス

チャンバ－カバ－チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット
プラスチック製
ピンセット

ガスケットスライドガスケットスライド
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1. ピンセットを使ってガスケットスライドのプラスチックカバーの端をつまみ、ゆっくりとはがします。ガスケ

ットスライドをパッケージから取り出します。この時、スライドの縁以外には触れないようにしてください。

必ずパウダーフリーの手袋を着用してください。 

 

 

 

 

 

 

2． チャンバベースの上に、ガスケットスライドを“Agilent”の文字あるいはバーコード番号が書かれている

面を上にして載せます。ガスケットスライドは、ハイブリダイゼーション溶液を介して直接アレイに触れ

ますので、ほこり等がつかないようにすばやくセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

 

 

3. ガスケットスライドがしっかりとチャンバベースにセットされているか確認し、正しくされていない場合

は、再度セットし直してください。 

（オプションのハイブリエイドを用いる場合、 

ここで次々ページの【参考手法】を参照下さい） 

 

 

 

 

4. ハイブリダイゼーション溶液をガスケットスライド上にアプライします。アレイスライドのバーコード番号

およびアプライしたサンプル位置を記録しておきます。 

アレイフォーマット
8pack
4pack
2pack
1pack

アプライする量(1アレイあたり)
40uL
100uL
240uL
490uL

調製した量(1アレイあたり)
50uL
110uL
250uL
500uL  
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5. ハイブリダイゼーション溶液がガスケットのふちまで広がらないように、ガスケットの中央部分にアプラ

イしてください。スライドグラス上の全てのウェル間で、液面の高さが揃うように、ゆっくりと均等に液を

配置します。 

 

 

 

 

 

 

 

サンプルをアプライしないウェルがある場合、空白ウェルには、水で 1x の濃度に希釈をした GE 

Hybridization Buffer HI-RPM を、アレイのフォーマットに応じて、上の表の量に従いアプライして下

さい。 

 

（オプションのハイブリエイド用いる場合、ここで次ページの【参考手法】を参照下さい） 

6. アレイ面(Agilent と書かれているバーコード面) を下にして(数字が書かれている方のバーコード面は

上に)、マイクロアレイスライドをチャンバベースにセットされているガスケットスライド上に載せます。こ

のとき、アレイスライドの縁またはバーコードシール部分を持つようにしてください。マイクロアレイスラ

イドを水平に保ったままガスケットスライドにのせます。 

アレイを正しくセットした後、チャンバや重なっているスライドグラスを動かさないようにしてください。

ハイブリダイゼーション溶液が漏れる原因になります。 

注意 2 枚のスライドのバーコードが、正しい位置で重なり合うようにセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

 

 

注意 1スライドに複数のアレイが搭載されているタイプで、チャンバカバーをセットする前、“サ

ンプル溶液が接しているアレイ”と“接していないアレイ”があるように見える場合があり

ますが、問題ありません。アレイスライドを乗せた後は、位置の微調整などは行わず、す

ぐチャンバカバーを乗せて下さい。 
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※参考手法 

ハイブリエイドを用いることにより、手作業では水平に降ろしづらいマイクロアレイスライドを、サンプ

ルをアプライしたガスケットスライド上に安定して乗せることが出来ます。 

使用器具： ハイブリエイド (HYB-100) 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

① ガスケットスライドにサンプルをアプライし終

わった時点でチャンバベースの両端から各

ハイブリエイドを差し込み、突き当たるまで動

かします。ガスケットスライドの端を、ハイブリ

エイドの突起部分が覆うような形となります。 

 

② アレイ面(Agilent と書かれているバーコード

面) を下にして(数字が書かれている方のバ

ーコード面は上に)、マイクロアレイスライドを

ハイブリエイド上に乗せます。アレイスライド

の縁またはバーコードシール部分を持つよう

にして下さい。バーコードシール側を先にハ

イブリエイドの上に置き、そこを押さえながら

もう片方をゆっくり下に倒すと作業が容易で

す。チャンバベースの 4 つの突起に当たらな

いように注意して下さい。この時、アレイスラ

イドはハイブリエイドに支えられてハイブリ液

には接していません。 

 

③ 左右のハイブリエイドを同時に引き抜いて下

さい。アレイスライドが水平に落ち、ガスケッ

トスライドと正しい位置で重なります。アレイ

スライドを乗せた後は、位置の微調整などは

行わず、すぐチャンバカバーを乗せて下さ

い。引き抜く先に障害物などが無いようにし

て下さい。 
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7. チャンバカバーを、チャンバベースの上にセットします。カバーの向きを間違えないように注意してくだ    

さい。 

 

8． クランプアッセンブリを、チャンバベースの丸くなっているコーナー側から差し込み、完全にストップす

る位置まで移動させます。ストップする位置は、ちょうどチャンバの中央部になります。 

 

 

 

 

 

 

チャンバが水平に保たれていることをご確認した後、手でスクリューをしっかり締めます。チャンバに

ダメージを与える可能性があるので、ペンチなどの道具は決して使用しないでください。 

 

 

 

 

 

9． 組み立て終了後、チャンバを垂直方向にして 2,3 回、回転させて、ハイブリ溶液がスライドガスケット

の全面に行き渡るようにします。次に、チャンバ内の泡が自由に動くことができるか確認してください。

ハイブリ溶液が行き渡っていない部分や、固定している泡によりハイブリむらが起きる場合があるの

で、泡が動かない場合にはチャンバを手で軽く振り、泡を移動させます。 

 

 

10．残りのスライドも同様に、上記の作業を行ってください。 
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11． チャンバの組み立てがすべて終わりましたら、予め 65℃にセットしたオーブンのローターに差し込

みます。ハイブリダイゼーション中に外れることがないように、両端をしっかりと差し込んで固定して

ください。 

複数のスライドグラスをハイブリダイズするときは、必ずローターのバランスをとってチャンバをセッ

トするようにしてください。チャンバが奇数の場合は、スライドグラスなしでチャンバを組み立て、ロー

ターの対面にセットし、バランスをとるようにしてください。 

 

 

 

 

 

 

 

 

 

 

 

 

組み立てたチャンバは、下図 a のようにチャンバのねじが横向きになるように差し込みます（左右ど

ちらでも構いません）。下図 b のようにねじが正面あるいは背面に向いた状態では、ハイブリダイゼ

ーションが不均一となります。 

a.                                         b. 

 

 

12. ハイブリダイゼーションオーブンの扉を閉め、回転数を 10 rpm に設定します。 

 

13． 65℃で 17 時間ハイブリダイゼーションさせます。 

 

YES! NO! 

Agilent ハイブリダイゼーション 

オーブン (G2545A) 

ハイブリダイゼーション オーブンロータ 

(G2530-60029) 
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8-9. 洗浄の準備 

 

1. Triton X-102 の Gene Expression Wash Buffer への添加 

 

Wash Buffer の Expire date を確認してください。古い Buffer を使用するとノイズが上がる等トラブル

が発生する可能性があります。 

 

最終濃度 0.005%になるように、Triton X-102 を Gene Expression Wash Buffer1 と 2 に添加することで、

マイクロアレイの洗浄におけるアーティファクトの可能性を軽減することができます。 

 

10% TritonX-102 は Gene Expression Wash Pack(5188-5327)に含まれています。単体でもご購入いた

だけます(50mL、5185-5975)。 

 

Gene Expression Wash Buffer 1 と 2 の開封時に、以下の方法で 10% Triton X-102 を加えます。 

この操作は、Wash Buffer１にも 2 にも行います。 

開封時に添加すれば、その後洗浄時に添加する必要はありません。 

 

1-1）.ダンボール箱中の容器の、外蓋と中蓋を注意深く開ける 

1-2）.ピペットで 2mＬの 10％ Triton X-102 を容器中の Wash Buffer に加える 

1-3）.中蓋・外蓋をきっちり戻し、5・6 回容器全体を転倒混和して、注意深くかつしっかり混ぜる。 

1-4).中蓋・外蓋を外し、Buffer に添付の蛇口を取り付ける 

1-5).Wash Buffer の容器に『Triton X-102 添加済』と記載し、日付を記録する 

 

Gene Expression Wash Buffer 中の Triton X-102 の最終濃度が 0.005%になれば、開封済みのよ

り少ない量の Buffer にも添加することができます。 

 

 

2. Wash2 の保温 

洗浄前日から、Gene Expression Wash Buffer 2 とスライドグラス洗浄用ガラス容器(1 個)を 37℃

で保温しておきます。Wash Buffer 2 を別容器に移して少量温める場合は、蒸発を防ぐため密閉容器

を使用してください。 
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9．実験：２日目 

スライドグラス洗浄の前準備 

 

⚫ 洗浄を始める前に、以下の機器・器具を準備してください。 

➢ スライドグラス洗浄用ガラス容器（中 3） 

➢ スライドラック(サーモエレクトロン 109) 

➢ スターラー（2） 

➢ 回転子（ラック小（サーモエレクトロン 109）の場合 3.0cm 程度のもの 2 

ラック中（サーモエレクトロン 113）の場合 4.5cm 程度のもの 2）  

  ※回転子の大きさが十分でない場合、洗浄力が弱くなる恐れがあります。 

➢ タイマー 

➢ ピンセット 

➢ パウダーフリーの手袋 

パウダーフリーの表示があっても、蛍光を持つ粒子が手袋についている場合があります。事前に、確

実に手袋から微粒子が発生しないことをご確認ください。ビーカーに入れた洗浄バッファ 1 で手袋を

事前に洗い、手袋から垂れる洗浄バッファが白濁していないこと、および手袋をあらった後の、ビーカ

ー内の洗浄バッファに微粒子がないことを確認してください。手袋から発生する微粒子は、アレイの表

面に吸着して結果に大きな影響を及ぼします。なるべく手袋を洗浄バッファに浸さないで操作すること

をお勧めします(P.37)。 

 

スライドグラスの洗浄操作 

洗浄条件 

※ GC%の高い原核生物の場合は、ガラス容器 2 および 3 の洗浄をもう一度繰り返します。弊社では

GC含量が65.6%のMycobacterium tuberculosisで洗浄を繰り返すことが有効であることを確認し

ております(アプリケーションノート 5991-0879EN)。 

 

1. 以下の洗浄バッファを用意します。 

A ： 洗浄液 1: Agilent Gene Expression Wash Buffer 1 

B ： 洗浄液 2: Agilent Gene Expression Wash Buffer 2（37℃で保温してあるもの） 

洗浄バッファの Expire date を確認してください。古い洗浄バッファを使用するとノイズが上がる等トラ

ブルが発生する可能性があります。 

37℃のウォーターバスまたはオーブンで溶液を加温します。洗浄直前時まで 37℃で保温して下さい。

ガラス容器 洗浄バッファ 温度 用途 洗浄時間 

1 1 RT ガスケットスライドと 

アレイスライドの分離 

2 1 RT 洗浄 1min 

3 2 37℃ 洗浄 1min 
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弊社では、37℃で保温可能なスターラー付恒温槽（アズワン株式会社(品番：1-5088-01、P36 の写真

参照）あるいは株式会社日伸理化( SW-500NT))の利用を推奨しております。 

C ： アセトニトリル：下記 S&D 溶液を使う場合のみ使用します。ドラフト内で扱ってください。 

D ： S&D 溶液：Agilent Stabilization and Drying Solution ドラフト内で扱ってください。 

取り扱い方法 

Agilent S&D 溶液はアセトニトリルに溶解させたオゾン除去剤を含みます。オゾン除去剤は飽和状

態になっているため、沈殿物を生じる場合があります。目に見える沈殿があった場合には、以下の

手順で溶液を加温して、沈殿物を再溶解してください。 

注意 Agilent S&D 溶液は、揮発性、引火性の溶液ですので、取り扱いに注意を要して下さい。 

＜警告＞ 警告に従わず火事、爆発による個人的な傷害を負った場合、アジレントの保証対象外に

なりますので、充分注意して取り扱って下さい。 

 

S&D 溶液加温手順 

注意 S&D 溶液を扱う際は、火気は厳禁です。また電子レンジ（オーブン）は使用しないで下さい。

温度を急激に上げないで下さい。さらに、引火性物質を近くに置かないで下さい。 

① 37-40℃のウォーターバスまたはオーブンでゆっくりと溶液を加温します。S&D 溶液はビニル

袋に入れてからウォーターバスに入れると、ラベルがはがれません。十分な空気のヘッドスペ

ース容量がある容器に溶液をいれ、密閉した状態で加熱してください。 

 

注意 出荷時に S&D 溶液が入っていたオリジナル容器は加温にお使いいただけます。オリジナ

ル容器は 700 mL サイズで、500 mL の溶液が入っています。オリジナルと異なる容器を

使う場合には、この空気部分のヘッドスペースと溶液の割合がオリジナル時以上になるこ

とをご確認ください。沈殿物を完全に再溶解させるのに必要な時間は、沈殿物の量によっ

て異なります。沈殿量が多い場合には、オーバーナイトでの加温が必要になることもあり

ます。S&D 溶液は決してろ過しないでください。 

② 溶液を均一に溶解するために、緩やかな攪拌が必要になる場合があります。必要に応じて、ヒ

ュームフード(ドラフト)内で火気を避けて行ってください。 

③ 沈殿が溶解しましたら、室温に戻してから使用してください。洗浄に使用する際は、マニュアル

の詳細に従って、ヒュームフード（ドラフト）内で行って下さい。 

 

2 下記の通り、3 つあるいは 5 つの洗浄用ガラス容器を準備します。 

ヒュームフード(ドラフト)内で、下記の通り、5 つのガラス容器を準備します。 

アセトニトリルおよび S&D 溶液を使わない場合はヒュームフード内で扱う必要はなく、またガラス容

器は 3 つ準備します。 

オゾンフリーブースがある場合は、オゾンフリーブース内で洗浄の準備・作業を行ってください（アセト

ニトリルおよび S&D 溶液は必要ありません）。  
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0 min 5 min

15 min 30 min

注意 ハイブリダイゼーションチャンバの分解を始める前に、すべての必要な洗浄液とガラス容

器の準備を行ってください。洗浄・乾燥のステップは、できるだけ効率的に行って下さい。 

注意 注意深く洗浄プロトコルに従ってください。また指定の器具を使用してください。洗浄時間

を守ることは非常に重要です。洗浄時間がプロトコルの時間から外れた場合には、結果

がばらついてしまう場合があります。また、スライド洗浄を行う際の攪拌には、シェーカー

を使わずに、必ずマグネットスターラーを使用して下さい。 

以下のようにガラス容器を 3 個あるいは 5 個用意します。 

ガラス容器 1: 洗浄バッファ 1、 ガスケットの解体用。 

ガラス容器 2: 洗浄バッファ 1、 スライドラックと回転子を中に入れておきます。 

ガラス容器 3：洗浄バッファ 2（37℃に保温したもの）、 回転子を中に入れておきます。 

スターラー付恒温槽がある場合には、37℃に設定して、ガラス容器 3 をセットします（写真参照）。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ 1 の洗浄が開始するまで、37℃で保

温してある洗浄バッファ 2 を加えないで下さい。 

 

 

ガラス容器 4：アセトニトリル（S&D 溶液を使うときのみ使用）、 回転子を中に入れておきます。 

ガラス容器 5：S&D 溶液（オプション）、 回転子を中に入れておきます。このガラス容器は S&D 溶液専

用にすることをお勧めします。 

 

3. オーブンからハイブリダイゼーションチャンバを取り出します。複数のアレイをハイブリダイゼーション

している場合も、チャンバは必ず１つずつ取り出すようにしてください。泡が形成されているか、また

泡が自由に動いているか確認してください。 

 

注意 チャンバをオーブンから取り出し、室温で静置すると、放置時間に応じて、ハイブリ液の覆って

いる部分と気泡の部分で、シグナル強度に差異を生じます（下図参照）。オーブンから取り出したチャ

ンバは、必ずすぐに解体し、ア

レイスライドを洗浄バッファ 1

中のスライドラックに移すこと

が重要です。また複数枚のス

ライドを一度に洗浄する場合

も、1 スライドずつ取り出し、解

体の直前まで、規定の温度に

保温されていることが重要で

す。 

 

スターラー付恒温槽 

室温放置の影響を検証したデータ 
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4. チャンバの分解 

a. チャンバを水平な台の上に置き、スクリューを逆時計回りにまわしてゆるめます。 

b. クランプアッセンブリを外し、チャンバカバーを取り除きます。 

c. 手袋をはめた手で、チャンバベースから重なっている 2 枚のスライドを同時に取り出します。この

時スライドの両端をしっかり持つようにしてください。すぐに、アレイスライドを上にし (数字が書

かれているバーコード面を上にして)、2 枚のスライドが重なっている状態でガラス容器 1 内の洗

浄バッファ 1 にいれます。この時なるべく手袋が洗浄バッファ 1 に浸からないようにしてください。 

 

5. 2 枚のスライドが完全に洗浄バッファ 1 に浸かった状態で、スライドのバーコード側から 2 枚のスライ

ドを離します。フラットピンセットを用いることにより、洗浄液に手袋を浸さないでアレイを洗浄すること

ができます。フラットピンセットがない場合は、参考手法の手順に従ってください。 

使用器具： フラットピンセット 33A (品番は p.9 参照)  

注意 丸い部分の半分以上でガラス面を持たないよう注意が必要。 

 

① 2 枚のスライドをピンセットで挟み、 ② バーコード側のピンセットを ③ 両手でスライドグラスを 

 立てた状態でガラス容器１に入れる。 2 枚のスライドグラス間に入れ しっかりはさみ、 

 アレイ面を傷つけないように ガラス容器２中の 

  ガスケットスライドをはがす。 ラックに運ぶ。 

 

 

 

 

 

 

 

 

 

注意 スライドグラスを扱う時は、バーコード部分かスライドグラスの縁を持つようにします。決してマイク

ロアレイに触れることがないように注意してください。できる限り洗浄バッファにアレイが浸った状

態で操作し、アレイが空気に触れる時間を最小限に押さえてください。 

※ 参考手法 フラットピンセット 33A がない場合は、下記方法で 2 枚のスライドグラスを離します。 

2 枚のスライドが完全に洗浄バッファ 1 に浸かった状態で、スライドのバーコード側から 2 枚のスライドを

離します。 

a. チャンバに付属の白いピンセットの先端を２枚のスライドの間に  

差し込み、ゆるやかにピンセットを上側か下側に回転させてス

ライド同士を離します。 

b. ガスケットスライドのみを容器の底に落としてください。 

c. アレイスライドをすばやく取り出し、洗浄バッファ１を入れたガラス容器 2 にセットされているラックにそ

っと差し込みます。 

1 2 3
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6. 残りのチャンバも同様に解体して、すべてのスライドをラックに差し込みます。一度に洗浄するアレイ

は 8 枚以下にするようにしてください。 

注意 スライドグラスをラックに差し込む際は、洗浄の効率を保つ持つために端は 3 つ以上、スラ

イドグラス間は 2 つ以上空けてください。19 スライドラックは最大 5 枚、30 スライドラックは

最大 8 枚洗浄可能です。全てのスライドで、アレイ面がラックの中心を向く向きに揃えます。 

19 スライドラック(Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ109) 30 スライドラック（Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ113） 

 

 

 

 

 

 

 

7. すべてのスライドグラスをスライドラックにセットできたら、 スターラーで中程度の回転数で、室温の

まま１分間攪拌します。 

注意 アレイスライドおよびスライドラックを入れた状態で、液面が波立つ程度の速さで攪拌してくだ

さい。スライドグラスの枚数、液量によって回転数は異なるので、その都度調節してください。

回転速度が十分でない場合、洗浄力が弱まる恐れがあります。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ 1 でスライドグラスを洗浄している間に、

ガラス容器 3 に 37℃で保温してある洗浄バッファ 2 を注ぎます。 

8 スライドラックを 37℃の洗浄バッファ２（ガラス容器 3）にすばやく移します。中程度の回転速度（液面

が波立つ程度の速さ）で 1 分間攪拌します。実験を成功させるために、この洗浄時間を厳守してくださ

い。 

≪オプション≫ GC%が高い原核生物をハイブリダイズした場合は、再度洗浄バッファ 1(ガラス容器 2)

で室温 1 分間、洗浄バッファ 2(ガラス容器 3)で 37℃1 分間洗浄を行います。 

※S&D 溶液以外のオゾンによる Cy5 蛍光退色の対策が行われている場合 

9. スライドラックを極めてゆっくりかつ一定の速度で洗浄バッファ 2 から引き上げます。スライドラックを

できるだけ水平に保ったまま、5-10 秒ほどかけてゆっくりと一定の速度でスライドラックを引き上げて

ください。スライドラックを溶液から出したり戻したりしないように注意してください。このステップで洗浄

は終了です。ステップ 16 以降をご覧ください。 

※オゾンによる Cy5 蛍光退色の対策として S&D 溶液を用いる場合 

10. 洗浄バッファ 2 からスライドラックを取り出します。この時、少しだけスライドラックを傾け、ラックから洗

浄バッファ 2 をできるだけ除きます。洗浄バッファ 2 のアセトニトリル、S&D 溶液への持ちこみは最小

限にして下さい。アセトニトリル、S&D 溶液を含むガラス容器 4、5 は、あらかじめスターラーが開始し

ている状態にしておきます。できるだけすばやくスライドラックをアセトニトリルが入ったガラス容器に

移動させることが重要です。その後、ラックを移したアセトニトリル中で、室温、10 秒間攪拌します。回

転速度は中程度あるいはそれよりも強い程度（液面が波立つ程度の速さ）にします。 
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11. アセトニトリルからスライドラックを取り出します。できるだけすばやくスライドラックを S&D 溶液が入

ったガラス容器に移動させて下さい。その後、S&D 溶液中で、室温、30 秒間攪拌します。回転速度

は中程度あるいはそれよりも強い程度（液面が波立つ程度の速さ）にします。 

注意 ラックを S&D 溶液の中に置いた時、白濁が数秒の間生じる可能性があります。これはラッ

クから持ちこされた洗浄バッファ 2 によるもので、パフォーマンスには影響しません。 

注意 次のステップで、スライドラックをゆっくりかつ一定の速度と方向で取り出します。 

12. スライドラックを極めてゆっくりかつ一定の速度で S&D 溶液から引き上げます。スライドラックをでき

るだけ水平に保ったまま、5-10 秒ほどかけてゆっくりと一定の速度でスライドラックを引き上げてく

ださい。スライドラックを溶液から出したり戻したりしないように注意して下さい。スライドラックを取り

出すのが早すぎる場合、スライドグラス上に白い粒子が生じることがあります。その場合には、直ち

にスライドラックを S&D 溶液中に沈め、再度極めてゆっくりかつ一定の速度で取り出してください。 

注意 S&D 溶液の滴がスライドラック下側のスライドグラスの端に残る場合がありますが、プロー

ブがプリントしてあるアレイエリア内に液滴がなければ、問題ありません。決してスライドを

振らないで下さい。スライドグラスのアレイエリア内に滴がついている場合は、すぐにスライ

ドラックを S&D 溶液に再度浸し、それから再度極めてゆっくりとかつ一定の速度で取り出し

てください。 

13 この操作でスライドグラスは乾燥しますので、その後ただちにスキャンを行うことができます。すぐに

スキャンをしない場合には、窒素パージして暗所で保管してください。必要でしたらスキャン後に、ス

ライドグラスはポリプロピレンスライドボックスに入れ（コルクなどの詰め物をしないでください）、真

空デシケータまたは窒素パージボックスに入れて暗所で保存します。真空デシケータの方が色素の

退色が見られるため、窒素パージボックスをお勧めしています。 

注意 S&D 溶液には、オゾン除去剤が含まれていますが、長時間のオゾン暴露によりシグナルは

退色していきます。オゾン暴露を最小限にするために、洗浄とスキャンは早朝または夕方

の遅い時間に行ってください。大気中のオゾン濃度は日中、特に交通量が多い時間帯に最

大になります。弊社のスキャナをお使いいただく場合には、一度にセットするスライドグラス

を 10 枚までにしてください。このようなスキャニグ操作を行うことで、大気中のオゾン暴露を

最小限にすることが可能です。スキャン中の退色をより確実に防ぐ場合は、P.41 のオゾン

バリアスライドカバーをご利用ください。 

S&D 溶液およびアセトニトリルの繰り返し利用回数は 3 回までになります。ただし繰り返し利用できる回

数は、洗浄バッファ 2 の持ちこみ量によって異なります。 

≪S&D 溶液の保存≫ 

ヒュームフード（ドラフト）内で手袋を着用し、S&D 溶液を密閉できる褐色または透明なガラス容器に移し

ます。液を移した後、少なくとも 30%以上のヘッドスペースがある大きさのガラス容器をお使いください。

漏斗を使用すると、簡単に溶液を移すことができます。S&D 溶液を移した褐色あるいは透明なガラス容

器は、暗所で保存して下さい。S&D 溶液は初回使用後、2 回まで、合計 3 回まで繰り返し使用できます。

S&D 溶液の繰り返し使用を終了した後は、HPLC 廃液およびフェノール廃棄と同様の方法にて揮発性

の溶剤として処分して下さい。  
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≪ガラス容器およびチャンバの洗浄法≫ 

洗浄に使用するガラス容器やラック、回転子等はマイクロアレイの洗浄専用にしてください。使用後は

洗剤を使わずに水洗いをしてください。洗剤が残っている器具を使用すると、マイクロアレイに洗剤が

付着し蛍光を発する場合があります。 

1. チャンバ、ガラス容器、回転子およびラックを水道水ですすぎます。汚れが気になる場合は、洗剤が

ついていないスポンジでこすってください。 

2. 超純水でよくすすぎます。5 回ほどすすいでください。 

3. 埃がつかないように乾燥させます。 

 

≪S&D 溶液を使用したガラス容器およびチャンバの洗浄法≫ 

洗浄に使用するガラス容器やラック、回転子等はマイクロアレイの洗浄専用にしてください。 

アセトニトリルあるいは S&D 溶液と接した器具は、ヒュームフード（ドラフト）内で手袋を着用し、水溶性の

有機溶媒（アセトニトリル、アセトン、エタノール）を使って洗浄します。その後、チャンバや洗浄バッファ用

のガラス容器と同様に、超純水でさらによく洗浄して下さい。 

使用後は洗剤を使わずに水洗いをしてください。洗剤が残っている器具を使用すると、マイクロアレイに

洗剤が付着し蛍光を発する場合があります。 

1. チャンバ、ガラス容器、回転子およびラックを水ですすぎます。汚れが気になる場合は、洗剤がつい

ていないスポンジでこすってください。 

2. 超純水でよくすすぎます。5 回ほどすすいでください。 

3. 埃がつかないように乾燥させます。 

 

≪ガラス容器などのメンテナンス≫ 

正しく操作されていても、汚れが洗浄器具に蓄積されるとアレイスライドに影響がでることがあります。 

スキャン画像にムラや粒上の汚れが観察されるなどの問題が起こった場合は、洗浄器具をクリーニン

グすると改善する場合があります。以下の手順に従い、クリーニングをしてください。 

ガラス容器の洗浄には、アセトニトリルあるいは IPA(イソプロパノール)を用います。 

アセトニトリルは劇物なのでドラフト内で使用するなど取扱いにご注意ください。 

1. ステンレスラック、スターラー、使用している場合はピンセットなどの洗浄器具をガラス容器に入れ、ア

セトニトリルあるいは IPA を満たした状態で数時間おきます。 

2. アセトニトリルあるいは IPA を廃棄した後ミリ Q 水で洗浄器具全てを徹底的にリンスしてください。 

3. 洗浄器具をホコリがつかない環境で自然乾燥してください。 

 

≪ミリ Q システムのメンテナンス≫ 

ガラス容器などをミリ Q 水でリンスする際、高い水質であることを確認してください。ミリ Q システムのフ

ィルターや UV ランプなどの使用期限が過ぎていると水質が悪くなり、ガラス容器などを介し、洗浄した

スライドグラスに影響を与えることがあります。 

参考値: 比抵抗 18.2MΩ･cm, TOC<4 
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10．Agilent スキャナを用いたスキャニング 

レーザーを安定させるために、スキャンを開始する 20 分前までにスキャナの電源を入れます。 

PC を起動した後にスキャナの電源を入れ、スキャナコントロールソフトを立ち上げます。詳細な手順は、

Appendix を参照してください。 

 

1. スキャニングの準備 

1. スライドをスライドホルダにセットします。スライドホルダをカローセルにセットした際に、数字のバーコ

ード面が見えるような向きで挿入します。 

a. B スキャナまたは C スキャナをお使いの場合 

 

 

 

 

 

 

 

 

 

 

≪オプション：オゾンバリアスライドカバーの使用≫ 

オゾンバリアスライドカバーを使用すると、スキャン中のオゾンによる蛍光色素の退色を抑えることがで

きます。下図のように、スライドホルダに挿入したアレイスライドに重なるように、オゾンバリアスライドカ

バーを置き、スライドホルダのカバーを閉めます。 

・スポット面を傷つける恐れがあるので、オゾンバリアスライドカバーの

向き（裏表、左右の向き）に気を付けてください。 

・スキャン中の退色のみに有効です。洗浄・乾燥時の退色はオゾンバ

リアスライドカバーのみでは防ぐことはできません。 

・オゾンフリーブースをご利用の場合は、使用する必要はありません。 

 

b. SureScan をお使いの場合 

 

① スライドホルダのカバーを開けます。 

② ’Agilent’と記載の面がホルダの上側になるように、’Agilent’の文字が奥側になるようにスライドを載

せます。 

アレイ面 

ラベルが手前、 

“Agilent”と記載の面 

がホルダの上側に 

くるように挿入 

 奥のつめにのせる 

① カバーを開けます。 
② スライドを載せます。 

“Agilent”と記載の面がホルダ

の上側にくるように挿入 
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③ スライドホルダのカバーを閉めます。閉める際カチッと音がし、固く閉まっていることを確認して下さ

い。カバーのしまりが緩い場合は他のホルダを使用してください。スライドホルダは 1 台のスキャナ

に 24 個ついています(足りなくなりましたら購入も可能です。お問い合わせください)。 

 

2． スライドホルダをスキャナのカローセル（SureScan の場合はカセット）にセットします。複数のスライド

グラスをスキャンする場合は、隣り合うスロットにセットしてください。また、H と書かれている Home

スロットにはセットしないでください。SureScan の場合は、どの位置にセットしても構いません。 

また、どちらのタイプのスキャナでもスライドホルダのカバーはきちんと閉めて下さい。完全に閉まっ

ていない状態でスキャンを開始すると、スキャナ内でスライドホルダが引っかかってしまい、エンジ

ニアによる修理が必要となることがあります。 

 

c. スライドのスキャン 

スキャナコントロールソフト ver.8（C バージョンスキャナ）をお使いの場合 

1. 画面下の“Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、“Start slot”と“End slot”で指定します。 

 

 

 

 

 

 

 

 

 

 

 

3. “Profile”リストから、ご使用のマイクロアレイフォーマットに適した Profile を選択します。アジレント

Exon マイクロアレイの場合は、“AgilentG3_GX_2Color”、原核生物 8x15K フォーマットの場合は

“AgilentHD_GX_2Color”を選択します。  

Profile リストの選択肢 

  <default> プログラムインストール後に現れるデフォルト設定 

AgilentHD_GX_1Color ：遺伝子発現アレイ 1 カラー(8x15K, 4x44K, 2x105K, 1x244K) 

AgilentG3_GX_1Color：遺伝子発現アレイ/Exon アレイ 1 カラー(8x60K, 4x180K, 2x400K, 1x1M) 

AgilentHD_GX_2Color ：遺伝子発現アレイ 2 カラー(8x15K, 4x44K, 2x105K, 1x244K) 

AgilentG3_GX_2Color ：遺伝子発現アレイ/Exon アレイ 2 カラー(8x60K, 4x180K, 2x400K, 1x1M) 

AgilentHD_CGH ：CGH/ChIP マイクロアレイ(8x15K, 4x44K, 2x105K, 1x244K) 

AgielntG3_CGH ：CGH/ChIP マイクロアレイ(8x60K, 4x180K, 2x400K, 1x1M) 

AgilentHD_miRNA：miRNA マイクロアレイ 

① 

② ③ 

⑤ 

④ 
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選択肢に“AgilentG3_GX_2Color”がない場合は、ウェブからダウンロードしコントロールソフトにインポ

ートするか、上記プロファイルのいずれかを選択後各項目を個別に変更してください。 

 

【プロファイルの入手およびインポート】 

1． 下記サイトから AgilentG3_GX_Profiles.zip をダウンロードし、PC に保存します（スキャナに付属

の PC ではなくて結構です）。 

https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Cu

stom&PageID=2074  

2． ダウンロードしたファイルを右クリック＞Open with(プログラムから開く)＞Compressed zipped 

folders あるいは Winzip と選択し、解凍します。  

3． 解凍したファイル(AgilentG3_GX_Profiles.pfl）をスキャナに付属の PC にコピーしてください。 

4. コントロールソフトの Tool> Profile Editor…と選択します。 

5. 現れた Profile Editor 画面で Import をクリックし、保存した解凍ファイル(AgilentG3_GX_Profiles.pfl）

を指定します。 

 

6． Yes をクリックし、 Profile Editor 画面の Close をクリックします。  

 

4. 選択したプロファイルの項目で、個別に変更する必要があればプルダウンで変更します。 

変更できる項目（太字が defalt です） 

1). Dye Channel:  Red（1 カラー(Cy5)） 

Green(1 カラー（Cy3）), 

Red+Green（2 カラー） 

 

2). Scan Region: Full Slide 

Agilent HD (アジレントアレイ) 

 

 

https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Custom&PageID=2074
https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Custom&PageID=2074
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3). Scan Resolution: 2um, 3um, 5um, 10um,  

double path (2um, 3um, 5um) 

※ C バージョンのスキャナでも 2um および 3um が選択肢

にない場合は高密度タイプのマイクロアレイ(8x60K, 

4x180K, 2x400K, 1x1M)に対応していません。 

 

4). TIFF file dynamic range: 20bit, 16bit  

 

 

5). R/G PMT gain: 100% ～ 1% 

 

6). XDR ratio: 0.5, 0.33, 0.2, 0.1, 0.05, 

  No XDR 

7). Output Path:  

※ 変更した設定は Profile に保存することができます。 [Profile>Save as] 

 

5. スキャン設定が確認できたら、“Scan Slot n-m”をクリックするとスキャンが開始します。 

6. スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

7. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

 

スキャナコントロールソフト ver.9.1（SureScan マイクロアレイスキャナ）をお使いの場合 

注意 ドアを手で開けないてください。エラーが発生します。 

カセットを手で動かさないでください。エラーが発生します。 

エラーが発生したら、スキャナコントロールソフトウェアを再起動する必要があります。 

1. 起動すると次の画面になります。

 

スロットステータス

インジケータ 

ファンクションボタ

ン 

セッティングペイン 

ステータスバー 

スロットテーブル 

ログ 

メニューバー 
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2. 初期化が終了すると、ファンクションボタンの Open Door ボタンがアクティブになります。クリックし、カ

セットにスライドをセットします。スライドがセットされているカセットは青色で表示されます。また、各

パラメータの編集ができるようになります。 

 

3. Scan Protocolから適切なプロトコルファイルを選択します。AgilentG3_HiSen_GX_2Color（1x1M、

2x400K、4x180K、8x60Kの場合）あるいは、AgilentHD_GX_2Color（1x244K、2x105K、4x44K、

8x15Kの場合）を選択します。 

ウィンドウ右側のセッティングペインでスキャン設定を確認してください。変更する必要があれば個別

にプルダウンメニューで変更できます。AgilentHD_GX_2Colorを選択した場合はResolutionを”5 

um”から”5 um high sensitivity”に変更してください。この設定をScan Protocolとして保存する場合

は次ページをご参照ください。 

 

4. 必要があればデータの保存先を変更します。※D drive内のフォルダを指定してください。 

 

 

5. ステータスバーでScannerのステータスがReadyであることを確認し、ファンクションボタンのAll to 

Queueボタンをクリックします。 

6. ファンクションボタンのStart Scanボタンをクリックするとスキャンを開始します。 

7. スキャンが終了し、Open Doorボタンがアクティブになったら、クリックします。 

8. スライドホルダを取り出します。 

9. コントロールソフトを閉じた後にスキャナおよびPCの電源を消してください。 

  

スライドがセットさ

れると青色で表示

されます。 
プロトコルファイルを選択

します。 
データの保存先を指定します。 
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≪変更したプロトコルをScan Protocolとして保存する場合≫ 

1． メニューバーの Tools から「Scan Protocol Editor…」を選択します。  

2． AgilentHD_GX_1Color または AgilentHD_GX_2Color を選択し Scan Protocol Editor 画面下部の

「Save As」をクリックし、「Save As New Name」ボックスで、今から設定する新しい Protocol Editor

に分かりやすい名前（例：AgilentHD_HiSens_GX_1color）をつけて保存します。  

3． 設定した新しい名前の Protocol が選択されているのを確認した後、Resolution という項目のプル

ダウンメニューを展開し、”5 um”から”5 um high sensitivity”に変更してください。 

 

4． Resolution が間違いなく High Sensitivityに設定されており、その他の項目に変更が加えられてい

ないことを確認した後、ボックス下部の Save をクリックします。  

 

今後のスキャン時には、この新規作成した Protocol を Scan Protocol として選択するだけで、高感度設

定でスキャンをすることが出来ます。  
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11．ハイブリダイゼーション後のマイクロアレイの画像化 

実習では、Feature Extractionソフトウェアによるイメージの簡単な確認法をご紹介します。より詳細につ

いては、Feature Extraction 英語版マニュアルをご覧ください。 

 

① Feature Extraction ソフトウェアの起動 

スキャンした画像ファイルを開きます。 

・tifイメージファイルをデスクトップのFeature Extractionショートカット  にドラッグ＆ドロップ。 

② バックグランドのむらの確認 

ログスケール表示によりバックグランドのむらを確認します。 

 

 

 

 

 

 

 

 

 

ログスケール 

リニアスケール 

切り替えボタン 
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③ イメージデータのスケールの確認 

両チャンネルのデータレンジを確認します。 

注意 ここでの確認はイメージデータ全体に対するものとなります（スポット以外のエリアも含みます）。 

スポットレベルで確認する（例：コントロールスポットを除く全遺伝子スポットに対してデータスケールを確認する）ためには、

スポット定量が必要になりますので御注意ください。 

 

③―１：カラーレンジの設定 

をクリック。 

イメージデータ全体に対し、１％から 99％の設定 

（デフォルト）における最大値・最小値を確認します。 

 

 

 

 

 

 

③―２： ヒストグラムの作成 

をクリック。Cropping Mode

を Off にします。 

 

アレイの左上隅で右クリックし、そ

のままポインタをアレイの右下隅

までドラッグさせます。 

 

上述のカラーレンジの設定と併せ

て、両チャンネルの分布が極端に

異ならないか確認します。 

 

 

 

 

 

 

④ クロップモードの ON/OFF 

クロップモードが ON の場合、ポインタの横にひし形のマークが表示されます。イメージをクロップすると

新しいウィンドウで切り取った画像が表示されます。OFF の場合、クロップ時にその大きさに合わせてウ

ィンドウが拡大表示されます。 

をクリックすることで ON/OFF の切り替えができます。
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⑤ カラースワップの確認 

色素交換を行ったアレイがある場合、２枚のアレイイメージを比べて大まかなスワップ傾向が見られるかを調

べます。 

 

 

 

 

 

 

 

 

 

 

 

この傾向を適正に見る為に、カラーレンジの設定を１％から９９％の 

設定（デフォルト）にしてください。 

設定に応じて、Cy3 の発現量が多い場合に緑色、Cy5 の発現が多い場 

合に赤色になるように表示されます。 

 

 

⑥ ラインプロット 

スポットの形状を確認します。 

 

 

 

 

 

 

 

 

 

 

 

 

ラインプロットを見たい領域の左上隅で左クリックし、そのままポインタを領域の右下隅までドラッグさせます。

次に、ラインプロットを見たい位置（上の図の場合、青線上のどこでも構いません）にポインタを合わせてダブ

ル左クリックします。 

このように、Feature Extraction する前に、ヒストグラムやラインプロットを使ってデータ抽出の妨げの可能性

となる異常スポットやバックグランドの確認をすることができます。 
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12．Feature Extraction ソフトウェアで数値化を行う前に  

- Feature Extraction 画面（ウインドウの構成）の説明 

Feature Extraction Ver.8 以降の画面は、Project Work Window（スポットの数値化の画面）と Image 

Work Window（イメージ確認の画面）があります。 

Project Work Window の画面構成（デスクトップ上の Feature Extraction ショートカット  か ら

立ち上げた場合の初期画面） 

 

 

 

 

 

 

 

 

 

 

※ Agilent が推奨している Default 設定の Protocol は、Feature Extraction をインストールする際に、自動的

にインストールされます。しかしながら、Agilent が推奨している Default 設定の Protocol は更新される場

合があります。最新の Protocol および Design File は後述の弊社 Web サイトからのダウンロードが可能

です（巻末参照）。 

 

Grid Template Browser 内に、新規 Design File を加える場合 

ダウンロードした Design File を解凍し、XML ファイルを“日本語が入らないパス”のフォルダに保存します。

Grid Template Browser Pane 上で右クリック→Add…を選択後、目的の Design File を選択して下さい（ま

たは、Tools > Grid Template > Add…を選択後、目的の Design File を選択）。 

※圧縮ファイルを解凍する際は、Winzip あるいはWindows XP以降に付属のソフト（解凍するファイル上で右

クリック＞Open with（プログラムから開く）＞Compressed(zipped)Folders と選択）を使用してください。 

 

各 Design File に Default の Protocol を設定する方法 

Grid Template Browser Pane に 格納さ れ て いる 目 的の

Design File を選択します。左ダブルクリック（または、Tools > 

Grid Template > Properties を選択）後、FE GridTemplate 

Properties（左図）の window が開きます。Default Protocol、

Default One Color Protocol に適切な Protocol を指定しま

す。 

 

FE Protocol Browser 内に、新規 Protocol を加える場合

FE Protocol Browser Pane 上で右クリック → Import…を選択後、目的の Protocol を選択して下さい（ま

たは、Tools > FE Protocol > Import…を選択後、目的の Protocol を選択）。 

Project 

Explorer  

Pane 

Project Work Window 

QC Metric Set Browser 各アプリケーション

での QC メトリックのセット。 

Grid Template Browser インストール済みの

Design File または Grid File のリスト表示。 

FE Protocol Browser 各数値化ステップの

アルゴリズムのパラメータを含む、アプリケー

ションごとのファイル。ダブルクリックで開いて

変更・保存可能。 
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13．Agilent Feature Extraction ソフトウェアによる数値化 

 

Step 1— Feature Extraction ソフトウェアの起動 

Project Work Windowを以下の方法で立ち上げて、スポットの数値化を行います。 

⚫ デスクトップのFeature Extractionショートカット  をダブルクリックします。このショートカットは

Feature Extraction ソフトウェアをインストールした時に自動的に作成されます。 

⚫ Start>Programs>Agilent >Feature Extraction からソフトウェアを開始させます。 

 

Step 2—FE projectへ数値化するイメージ(.tif)を追加 

 

1. ツールバーにあるAdd New Extraction Set(s)のアイコン を ク リ ッ ク し ま す 。 あ る い は 、

Project Explorer内で、右クリックをします。そして、Add Extraction…を選択します。 

 

2. tif.ファイルを選択して、Openをクリックします。複数のファイルを指定するときには、ShiftまたはCtrlキー

を押しながら選択します。 

 

3. Project Explorer内のProject下の階層にExtraction Setが、さらにExtraction Set下の階層にImage 

File、Grid Template（あるいはGrid File）、Protocolが現われることを確認して下さい。必要に応じて、

適切なGrid TemplateとProtocolを選択してください。 

 

 

 

 

 

 

 

 

 

 

 

Project ： Feature Extraction の Run 設定全体をまとめた情報です。1 つ以上の Extraction Set から

構成されています。 

Extraction Set ： 解析する tif 画像ごとに作成されます。Image File、Grid Template (Grid File)、

Protocol から構成されています。 

Image File ： 解析対象のマイクロアレイ画像のことです。 

Grid Template (Grid File) ： Grid 情報です。Agilent アレイのお客様は、Design File を意味します。 

Protocol ： イメージの数値化の際、適用する解析アルゴリズムの設定です。 

 

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project
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Step 3— Extraction Set Configurationおよび Project Properties タブシートでの設

定および確認 

 

１. Extraction Set Configurationタブシートの確認をします。 

⚫ Extraction Set Configurationタブシートを選択。 

⚫ Extraction Setで用いる構成（イメージ、Design File、Protocolなど）を設定、確認します。 

※ Protocolは2色法の数値化には、GE2_107_日付を選択してください。 

Design FileおよびProtocoについては巻末をご参照ください。 

 

 

 

プルダウンメニューにGrid Templateがない場合に、Grid TemplateをGrid Template Browserに追加してください。Grid 

Template Browserの枠内で右クリックをして、Addを選択します。追加したいデザインファイル(.xml)をブラウズし、Open

をクリックしてデータベースにインポートします。 

 

２. Project Propertiesタブシートでの設定確認、および設定を行います。 

⚫ Project Propertiesタブシートを選択する、あるいは、Project Explorer内の解析に用いるProjectをダブ

ルクリック。 

⚫ Projectの設定を確認、変更をします（解析結果ファイルのOutputフォルダの設定、結果としてOutput

するファイル種類の設定など）。 

 

Extraction Set Configurationタブシート 
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①出力方法の設定 

出力方法は以下の4つから選択することができます。 

None （出力しない） 

Local file only （ハードディスクに出力する） 

FTP send only （外部にファイルを転送する） 

Both local file and FTP send （両方に出力する） 

本実習では、TEXT、Visual Results、QC Reportの結果を出力します。これらの項目の設定を、Local 

file onlyと選択します。また、それ以外の項目（MAGE、JPEG、Grid）は、Noneを選択します。 

 

②出力ファイルの設定 

MAGE アレイの結果をXML形式で出力。解析にロゼッタ社のリゾルバー/ルミネーターを使用する場

合、Array Expressにデータを転送する場合などに必要。 

JPEG 各アレイ画像をJPEG形式で出力。この画像ファイルからは数値化はできないので注意。 

TEXT アレイの結果をタブ区切りテキスト形式で出力。解析にGeneSpring、エクセルなどを使用す

る場合に必要。 

※ TEXTファイルのOutput設定は、以下のOutput Package設定が可能です。 

Full ：数値化項目全ての結果を出力します。 

Compact ： 数値化項目の一部（通常、データ解析に用いると考えられる項目）の結果

を出力します。Fullに比べ、約1/3のファイルサイズとなります。 

GeneSpring, DNA Analytics/Agilent Genomic workbenchを使用する場

合はCompact推奨。 

Visual Results 数値化結果のTIFF画像へ重ね描きするのに必要な.shpファイルを出力。 

Grid グリッド合わせの詳細（スポット位置情報など）をCSV形式で出力。 

QC report 実験の成否をチェックするための項目を含んだレポートを出力。 

※ QC reportはPDFファイルあるいはHTMLファイルで出力できます。 

PDFファイルは“Local PDF file only”を、HTMLファイルは“Local HTML file only”を選択

してください。HTMLファイルの場合は数値化後、必ずQCReport_Graphsというフォルダ

と同じフォルダにHTMLファイルを保存してください。 

Same As ImageをTrueにしておくとスキャン画像が保存されているフォルダに、出力ファイルが保存さ

れます。スキャン画像と別のフォルダにファイルを出力する場合は、Same As ImageをFalseにし、

Result Folderの欄で保存先を指定します。 

 

３. 設定を確認したら、Projectの保存を行います。 

⚫ File > Save As後、Save Asのダイアログ画面が出てきますので、FE Project Data Files (.fep)ファイ

ルを保存するための適切なフォルダを選択および作成して下さい。 

⚫ フォルダ指定後、名前を付けて保存して下さい。  
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Step 4—Feature Extraction Project をスタート 

Project > Start Extractingを選択すると、Projectがスタートします。 

スタート後、Summary ReportタブとRunning Monitorが現われます。 

 

 

 

 

 

 

 

 

進行状況は、Running Monitorに表示されます。Project終了後、Summary Reportタブを選択していると、

Project Work Windowに、Project終了を示すSummaryが現われます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※ 4x180K フォーマットの出力結果は、1スライドあたりファイル名末尾 “…_1” ～ “…_4” の4つのデータ、

2x400K フォーマットの出力結果は、1スライドあたりファイル名末尾 “…_1” ～ “…_2” の2つのデータ、

8x15Kフォーマットの出力結果は、ファイル名末尾 “…_1_1” ～ “…2_4” の8つのデータが得られます。 

それぞれ、下図の位置のアレイに対応しています(バーコードラベルを左側、Inactiveサイトが手前の状態)。 

 

 

 

 

  

 

Summary ReportタブシートSummary Reportタブシート

 

Project 終了後Project 終了後

1 2 3 41 2 3 4

 

Running MonitorRunning Monitor

1_1 1_2 1_3 1_4

2_1 2_2 2_3 2_4

1_1 1_2 1_3 1_41_1 1_2 1_3 1_4

2_1 2_2 2_3 2_42_1 2_2 2_3 2_4
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Step 5—QC Reportの確認 

 

1. 出力された結果ファイルに、“pdf形式のQCReportファイル”があることを確認して下さい。 

2. “pdf形式のQCReportファイル”を開いて下さい。QC Reportを確認することができます。 

 

QC Reportは、以下の項目を示します。 

（各項目の詳細は、Help > Reference Guide で確認することができます。） 
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出力された

QC metrics

のテーブル 
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Step 6―Visual Resultの確認 

 

Step3で選択したVisual Resultファイルを使ってフラグ等の確認をします。 

1. Feature Extraction内に、画像を表示させます。メニューバーのFeature Extraction > Load Visual 

Resultを選択します。 

2. 該当するVisual Resultファイル（.shp）を選択します。このとき表示させている画像に対応するファイルを

選択してください。 

3. 画像にVisual Resultが重ね描きされます。 

4. クロップモードやズームイン機能、ログスケール表示機能を使って表示を調節します。 

 

 

 

 

 

 

 

 

View outliers onlyにチェックが入っている状態 

 

 

 

 

 

 

 

 

 

5. View > Extraction Results からVisual Resultsの表示法を選択できます。 

 

 

Help > Feature Extraction Output Quick Referenceで各リングの色が示すアウトライヤーを確認できます。 
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Step7. テキストファイルの確認 

以下の表は、Compact 設定で出力されたテキストファイルの主な項目です。 

通常データ解析では gProcessedSignal および rProcessedSignal をシグナル値、両シグナル値の比を

ratio、ProbeName を ID として使用します。 

これらの項目は数値化テキストファイルをエクセルで開くと、10 行目に表示されます。GeneSpring GX

をご使用の際は、出力ファイルの内容は変更せず、出力テキストファイルをそのまま GeneSpring に認

識させてください。 

 

 

項目(Green) 項目(Red) 内容 

 

FeatureNum フィーチャ番号 

ControlType フィーチャのコントロールタイプ 

ネガティブおよびポジティブコントロールは

数値化の際に Feature Extraction が各種

補正係数などを計算する際に使用します。

生物学的な解析には必要ありません。 

コントロールプローブ以外のプローブ 

-1 ネガティブコントロール 

1 ポジティブコントロール 

ProbeName 各 60mer の配列に対応した Probe ID 

IDSystematicName 各プローブがターゲットとしている配列の

ID。可能な限り公的なデータベースの ID 

を使用。 

gProcessedSignal rProcessedSignal 全ての数値化プロセスを経たシグナル強

度。1 色法の場合は、Surrogate 後の値、

2 色法の場合は色素補正後の値。 

gBGSubsignal rBGSubsignal バックグランド補正を行った後、各種補正

を行う前のシグナル強度。
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Feature Extraction 由来のフラグ 

 

 

項目(Green) 項目(Red) 内容 

 

gIsSaturated rIsSaturated 0 サチュレーションしていないフィーチャ 

1 サチュレーションしているフィーチャ 

gIsFeatNonUnifOL rIsFeatNonUnifOL 各フィーチャ内のシグナルの均一性を 

検証。 

0 フラグが立っていないフィーチャ 

1 フラグが立った不均一なフィーチャ 

gIsFeatPopnOL rIsFeatPopnOL アレイ内に繰り返し搭載されている同じ 

配列を持つプローブシグナルの均一性を 

検証。1 回しか搭載されていないプロー 

ブは対象外。 

0 フラグが立っていないフィーチャ 

1 フラグが立ったフィーチャ 

 

gIsPosAndSignif rIsPosAndSignif フィーチャのシグナルがバックグランドと 

有意に差があるかを判定。判定法は両 

側t検定。 

0 バックグランドと差がないフィーチャ 

1 バックグランドと差があるフィーチャ 

gIsWellAboveBG rIsWellAboveBG フィーチャのシグナルがバックグランドと 

有意に差があるかを判定。BGSubsignal 

の値が、バックグランドの標準偏差（エラ 

ーモデルから算出）を各アレイフォーマッ 

トの最適値倍（デフォルトは13倍）した値 

よりも大きいかどうかで判定。 

PosAndSignifよりも厳しい判定法。 

0 バックグランドと差がないフィーチャ 

1 バックグランドと差があるフィーチャ 
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スポット数値化と解析 

 

DNA マイクロアレイの解析には 2 種類のソフトウェアを使用します。 

 

まずスキャンで得た TIFF イメージからスポットの数値化を行うソフトウェアが必要になります。ここで

はスポットのシグナル強度、ローカルバックグランドのシグナル強度などが算出されます。Agilent ス

キャナに付属する Feature Extraction はこれに加えてバックグランドの引き算、色素補正を行い、

最終的な 2 サンプルの発現比（LogRatio）および統計処理されたエラー値と P 値を決定します。 

 

上記のスポット解析を行った数値データを用いて、高度なデータ解析を別のソフトウェアで行います。

一番身近なものではエクセルが挙げられますが、エクセルはアレイごとの結果を解析するのには適

していますが、複数アレイの結果の比較(クラスター解析など)には適していません。データ解析を行

うソフトウェアは数多く製品化されていますが、本トレーニングではエクセルで数値化のアウトプット

データを理解した上で、GeneSpring GX を使ったデモを行い、さらに生物学的意義を付け加えて

いきます。 

 

Feature Extraction など GeneSpring GX など 

図:スポット解析、データ解析の流れ 

 

 

スポットの数値化は以下の手順で行われます。 

① スポットの中心位置の決定 

② スポット（Feature）およびバックグラウンド領域の決定 

③ スポット（Feature）のシグナル強度計算 

④ バックグランドのシグナル強度計算 

⑤ バックグランド補正 

⑥ Multiplicative Detrending 

⑦ 色素補正 

⑧ 発現差計算 
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Feature Extraction の結果解析 

  

サンプル間の発現差を求めるもっとも単純な方法は、Cyanine3 と Cyanine5 の色素強度の比

(FoldChange)になりますが、この方法では以下の図に示したように、Up と Down のスケールが非

対称になってしまいます。コンピュータを用いたデータ解析を進めるためには適切ではありません。 

 

そこで一般的に、Up と Down が対称なスケールになるように、色素強度比の対数(LogRatio)が計

算されています。 

 

フィーチャエクストラクションでは、LogRatio として底が 10 の対数(log10)が用いられています。 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Cy3

Cy5

Cy3

Cy5
分数

10 2 3… ∞

UpDown

10 2 3… ∞

UpDown

Ratio:　UpとDown非対称なスケール

Log Ratio:UpとDown対称なスケール

0-2 -1

UpDown

1 2

Log Ratio:UpとDown対称なスケール

0-2 -1

UpDown

1 20-2 -1

UpDown

1 2

LogRatio : log10

Cyanine3色素強度

Cyanine5色素強度
LogRatio : log10

Cyanine3色素強度

Cyanine5色素強度
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Appendix1:total RNA の品質チェック 

Step1．UV-Vis による Total RNA の評価 

本プロトコルでは、測定に用いるサンプル量を抑えるため、NanoDrop の使用をお勧めいたします。 

NanoDrop を使用する場合は、メニュー画面で Nucleic Acid Measurement をクリックし、Sample 

Type は RNA-40 を選択します。 

⚫ 少なくとも、以下の 4 つの波長における吸光度を測定して下さい。 

A230  グアニジンイソチオシアネートや塩類・糖類、その他有機溶媒などの混入を検出します 

A260  total RNA の濃度を測定します 

A280  タンパク質・フェノールの混入を検出します 

A320  異常な吸収がないかをチェックします 

⚫ 以下の基準を満たしているかをチェックして下さい。 

A260/A280＝1.8～2   A260/A230>2.0 

この基準を満たしていない場合、タンパク質や有機溶媒の混入が疑われ、ラベル化反応がうまくい

かないことが予想されます。また、RNA を正確に定量できていない可能性もあります。抽出をやり

直すか、混入物を除去するための追加の精製を行って下さい。 

 

⚫ UV スペクトルを採取し、スペクトルパターンを記録して下さい。 

純度の高い核酸のスペクトルは、230nm に谷、260nm に吸収極大があり、長波長側の吸光度

は 0 で安定しています。 

 

Step2．Agilent 2100 Bioanalyzer による total RNA の評価 

UV-Vis の測定結果からは RNA がどのぐらい分解しているかを知ることはできません。必ず電気泳

動で RNA が分解していないか、確認してください。本プロトコルでは、Agilent 2100 Bioanalyzer を

推奨しています。 

Agilent 2100 Bioanalyzer を用いる場合は、サンプルの濃度に応じて、RNA6000 Nano kit あるいは

Pico kit を使用してください。実際の操作は各キットの説明書に従ってください。 

電気泳動の結果から下記 3 点を確認し、分解していないか評価してください。 

⚫ 18S および 28S リボソーマル RNA（あるいは生物種特有の rRNA）の明確なピークが確認できる 

⚫ 18S および 28S リボソーマル RNA のピーク間に分解物がない 

⚫ 18S リボソーマル RNA ピークと Lower Maker 間に分解物がない 

（5S リボソーマル RNA は精製法によって高さが変わります。カラムを用いて total RNA を精製した場合、

通常低くなります。） 

Agilent 2100 Expert Software は、total RNA の品質の指標として RNA Integrity Number（RIN）を自

動で算出します。RIN を使うと、RNA の分解具合などの質の標準化が容易になります。 

RIN や Bioanalyzer に 関 す る よ り 詳 細 な 情 報は 、 以 下 の ウ ェ ブ サ イ トよ り 、 “ RNA integrity 

number(RIN)-Standardization of RNA quality control” (part number 5989-1165EN)をご覧下さい。

www.agilent.com/chem/labonachip 

http://www.agilent.com/chem/labonachip
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下の図では、分解具合の異なる 3 種類の total RNA を分析した結果のエレクトロフェログラムを示しています。

お客様が、品質の悪い Total RNA による実験結果の偏りを排除するために、RIN の各々の閾値を実験系ごと

に決定することが重要となります。 

 

 

 状態の異なる（ヒト）Total RNA を Eukaryote total RNA Nano assay によって分析した結果 

赤…RIN 8.1 青…RIN 5.9 緑…RIN 3.6 
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Appendix2:サーマルサイクラーを用いた実験プロトコル 

ウォーターバスの数に限りがある場合、サーマルサイクラーを用いて実験をすることも可能です。ただし、ウォ

ーターバスを使用した場合と比べると、cRNA の収量は少し下がる傾向があります。 

 

Step1.サーマルサイクラーのプログラム設定 

下記のようにプログラムを設定します。 

プログラム 1：65℃ 10 分、4℃ hold 

プログラム 2：40℃ 2 時間、70℃ 15 分、4℃ hold 

プログラム 3：40℃ 2 時間、4℃ hold 

4℃のステップは 5 分で十分です。次のステップの準備が整っていない場合は、4℃に置いてください。 

Heat Lid の設定にしてください。 

 

Step2.totalRNA からの cDNA 合成  

1．p.14 に従い Spike-Mix を希釈します。 

2．25ng から 100ng の total RNA を PCR チューブあるいは 96 穴 PCR プレートに 2.3uL 加えます。十分量

のラベル化 cRNA を得るためには、8x15K、8x60K、4x180K、2x400K フォーマットの場合は 50ng 以上の

total RNA、1x1M フォーマットの場合は 100ng の total RNA を用いることをお勧めいたします。 

3．p.15 の表に従い、を調製します。 

4．3uL の WT primer Mix を各チューブに加え、よく混ぜます。総量は 5.3uL になります。 

5．サーマルサイクラーに PCR チューブあるいは 96 穴 PCR プレートをセットします。プログラム 1 を走らせ、

熱変性を行います。 

6．65℃ 10 分の過程が終了したら、氷上に移します。 

7．p.16 の表に従い、cDNA Master Mix を調製します。 

8．4.7uL の cDNA Master Mix を各サンプルに加え、ピペッティングで良く混合します。総量は 10uL になりま

す。 

9．サーマルサイクラーに PCR チューブあるいは 96 穴 PCR プレートをセットします。プログラム 2 を走らせ、

cDNA 合成反応をスタートします。 

 

Step3.ラベル化 cRNA の合成 

1．1.5mL のチューブに、p.17 の表に従い Transcription Master Mix を調製します。使用直前に T7 RNA 

polymerase Blend をマスターミックスに加えます。ピペッティングで良く混合します。 

2．サンプルはマスターミックスを添加するまで、サーマルサイクラー中で 4℃、あるいは氷上に置きます。 

3．各サンプルに、6uL の Transcription Master Mix を加え、ピペッティングで良く混ぜます。 

4．サーマルサイクラーに PCR チューブあるいは 96 穴 PCR プレートをセットします。プログラム 3 を走らせ、

cRNA 合成反応をスタートします。 

5．p.18 に従い、ラベル化 cRNA を精製します。その後の操作は、1.5mL チューブでラベル化を行った場合と

同じです。 
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Appendix3：詳細なスキャナの起動手順 

 

B スキャナまたは C スキャナをお使いの場合 

1. PC の電源を入れログインします。 

2. PC が完全に立ち上がってからスキャナの電源を入れます。 

3. スキャナ前面のLED が緑とオレンジに点灯している（点滅ではありません）ことを確認します。電源を入れ

てから数分かかります。 

4. スキャンコントロールソフトを立ち上げます。スキャナと PC の通信が始まってから、レーザーが安定する

まで 20 分ほどかかります。 

 

SureScan をお使いの場合 

1. PC の電源を入れログインし、スキャナの電源を入れます。 

2. スキャナ前面右上にある LED がオレンジ→白色の順に光り、しばらくすると消灯します。LED が消灯する

まで待ちます。（電源を入れてから数分かかります。） 

3. スキャンコントロールソフトを立ち上げます。 

4. スキャナの初期化が始まりますので、初期化が終わるまで待ちます。 

5. スキャンコントロールソフトの画面右下にある Scanner Status が Ready になることを確認します。 

※デフォルト設定では、Ready の状態で 5 分間、スキャン開始せずに待機すると、省電力のためレーザ

ーが OFF になります。スキャンのために Queue に入れるとレーザーが自動点灯し、Status が Ready に

なります。 

 

 

いずれのスキャナでも、スキャン後はスライドフォルダを取り出し、コントロールソフトを閉じてください。その後

スキャナおよび PC の電源を落としてください。 

 

通信エラーが起きた場合などは、PC とスキャナの電源を切った後 10～15 分ほど待ち、上記手順で PC とス

キャナの再起動をお試しください。それでも改善しない場合は、エラー内容を弊社サポート窓口までお知らせく

ださい。 
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SureScan で’Initialize logger failed’のエラーが出た場合の対処法 

 

SureScan の場合、スキャンコントロールソフト を立ち上げた際に以下のエラーメッセージが出て、スキャナ本

体と通信できない事がありますが、次の手順でエラーを解消することができます。 

 

 

1. 上記のエラーメッセージの OK を押します。 

2. スキャンコントロールソフトで Tool > Log files と選択し、ログファイルのフォルダを開きます。 

3. スキャンコントロールソフトを終了し、装置の電源もオフにします（PC の再起動は必要ありません）。 

4. 上記 2 で開 いたフォルダ、 C:¥ProgramData¥Agilent¥MicroArrayScanner¥Logs  の中にある、

ExceptionLog.txt というファイルをデスクトップなど別のフォルダに移します。 

5. 再度、スキャナ本体の電源をオンにし、スキャナ右上のLEDランプが黄色に点灯し消灯後、スキャンコン

トロールソフトを立ち上げてください。 

6. 移動した ExceptionLog.txt は元の場所には戻さず、破棄して下さい（スキャンコントロールを立ち上げ

た際に Log のフォルダには既に新しい ExceptionLog.txt が作成されています）。 

 

C ドライブ中に ProgramData がない場合、ProgramData が隠しファイルになっていますので、下記の方法で

表示ください。 

【Windows 7】 

a)     スタートメニューから [Control Panel ] を選択 

b)     [ Appearance and Personalization ] を選択 

c)     [ Folder Option]を選択 

d)     [ Folder Option] ダイアログが表示されるので、[ View ] タブを選択 

e)     [ Advanced Settings] の[ Hidden files and folders ]の中で[ Show hidden files, folders, and 

drives ] 

を選択し、apply 

【Windows 10】 

a)     スタートメニューから Explore を選択、またはスタートメニューを右クリックし File Explore を選択 

b)     現れた Explore ウィンドウで View タブ を選択 

c)     File name extensions および Hidden items にチェックを入れる 
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Appendix4：Feature Extraction 用デザインファイルのダウンロードサイト 

デザインファイルは eArray からダウンロードすることができます（ご使用の際、ご登録が必要となります）。 

【eArray】 http://www.chem-agilent.com/contents.php?id=29443 

 

1．お使いのマイクロアレイのデザイン番号 (Design ID)を確認します。 

デザイン番号： マイクロアレイのラベルに記載されて

いる 12 桁の番号の「25」に続く 5 桁の番号の頭に「0」

を付けた 6 桁の番号。この 12 桁の番号は Feature 

Extraction の出力ファイルからも確認できます。 

例）12 桁の番号が 251469312345 の場合… [14693]

の頭に「0」を付けた 014693 

 

2．eArray にログイン後、画面右上の 

「Application Type」を Expression に変更。 

 

 

 

 

 

3．HomeタブでMicroarrayにチェックを入れ、Design ID

欄にデザイン番号を入れてSearch。 

 

 

 

 

4．Search 結果から「Download」を選択 

 

5．Internet Explorer の Pop Up Blocker を

Off にし、「EXTERNALFULGEML」（＝

Feature Extraction 用デザインファイル）

をダウンロード  

http://www.chem-agilent.com/contents.php?id=29443
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Appendix5：Feature Extraction 用 Protocol のダウンロードサイト 

 

弊社スポット数値化ソフトウェア、Feature Extraction によるスポットの数値化を行う際、イメージの数値

化に適用する解析アルゴリズムを設定した Protocol ファイルが必要です。 

Agilent が推奨している Default 設定の Protocol ファイルは、下記サイトからダウンロードが可能です。 

http://www.genomics.agilent.com/article.jsp?pageId=2037 

 

 

 

※ 2017 年 4 月現在、上記の Protocol のダウンロードが可能です。 

※ プロトコルファイルは、最新のものではなく、お使いの Feature Extraction Software と一致したバ

ージョンをお使い下さい。 

※ 各 Protocol の詳細は、Protocol Use のリンク先をご参照下さい。 

 

 

QC Metric Set のダウンロードサイト 

最新の QC Metric Set は下記サイトからダウンロードできます。Feature Extraction 9.1 以降に対応して

います。 

http://www.genomics.agilent.com/article.jsp?pageId=2041 

 

http://www.genomics.agilent.com/article.jsp?pageId=2037
http://www.genomics.agilent.com/article.jsp?pageId=2041
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Appendix5：マイクロアレイのレイアウト 

 

キットに付属のデザインファイルには、アレイの各プローブの位置情報（レイアウト）やアノテーション情報が含

まれております。このデザインファイルは、アジレント DNA マイクロアレイスキャナで読み取った向きを基準と

して作成されております。弊社のスキャナはアレイ面を裏側にから、またバーコードを左位置で読み取るので、

ほとんどの他社製品のスキャナで読み取ったイメージと向きが異なります。数値化データとプローブ情報を組

み合わせる際には、お使いのスキャナの読み取り方向にあわせて並び替えたデザインファイルをお選び頂く

必要があります。並び替えたデザインファイルもマイクロアレイキットに付属の DVD に含まれておりますので、

次の点をよくご確認したうえ、適切なデザインファイルをお使いください。 

※カスタムアレイに付属の DVD にはデザインファイルは含まれません。カスタムアレイのデザインファイルは、

eArray からダウンロードしてください。 

 

1) アレイの表面側(front side)からスキャンしているか。(バーコードにAgilentの文字がある側からスキャン) 

2) 得られたイメージ画像が、スライドグラスを横方向（landscape）にスキャンしたものか。縦方向（portrait）に

スキャンしたものか。バーコードが得られたイメージに対して、上下左右のどこに位置しているかでご判断

ください。 

 

デザインファイル名には、アレイ種類（Design ID）とファイル更新日の情報が含まれております。 

デザインファイル名の例： 

 

 

 

 

 

 
(Design ID) 
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Appendix6：弊社 DNA マイクロアレイサポート用ホームページ 

弊社の DNA マイクロアレイサポート用ホームページでは、上記のほかにも新製品や最新プロトコル、 

アプリケーションノートなど様々な情報を掲載しております。 

(アメリカ本社ウェブサイト)  http://www.genomics.agilent.com/en/home.jsp# 

本社のサイトに掲載してありますキャンペーンの中には、日本国内ではご利用いただけないものもございま

すことをご了承ください。 

 

アジレントゲノミクス 日本ウェブサイト 

 

 

 

 

 

 

 

 

 

 

http://www.agilent.com/chem/genomics:jp 

 

• eArray  

• 実験に必要なものリスト 

• サポートページ 

サポートページにて、最新版の和文マニュアルを 

ダウンロードすることができます。 

http://www.agilent.com/chem/genomics:jp
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